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MatSeis

Overview

This document consists of seven sections and five appendices. The seven sections discuss the

development history of MatSeis, guide the user through installation and setup, and provide a tuto-

rial on MatSeis use. A brief description of each is given below:

• Section 1 provides an introduction to MatSeis, including the development history, and intro-

duces the notation conventions to be used throughout the rest of the document.

• Section 2 outlines the hardware and software requirements to run MatSeis and tells how to

install the software and how to customize the configuration.

• Section 3 discusses the supported data formats and gives the parameter settings needed for

each.

• Section 4 is a detailed but by no means inclusive MatSeis tutorial. The idea is not to teach the

user to use every function in MatSeis but rather to provide enough guidance to get started.

MatSeis is designed to be intuitive so the user should be able to learn the rest on his/her own.

• Section 5 is an introduction to Map Tool, a graphical interface for locating origins and sta-

tions. Covers environmental settings, data formats, mapfile formats, pulldown and popup

menus used by Map Tool. Because of Map Tool’s lengthy description, we’ve devoted an entire

section to it.

• Section 6 is an introduction to the four basic data types and how to use the functions associ-

ated with them. This is essential information for anyone who wants to put/get data from Mat-

Seis to matlab and for anyone who wants to create their own MatSeis functions.

• Section 7 provides suggestions for what the reader should try next after completing the man-

ual.

The appendices list in detail the functionality of MatSeis. For the experienced MatSeis users, this

is probably the most useful part of the documentation as it will include any new functionality. A

brief description of each follows:

• Appendix A lists all of the items on each of the menu pulldowns.

• Appendix B lists the items for each of the four types of data popups (arrival, origin, travel-

time and waveform).

• Appendix C lists and describes the buttons in the main MatSeis GUI.

• Appendix D lists the environmental variable used to set parameters for a wide variety of Mat-

Seis functionality. Generally these are set in a user’s configuration (config) file.

• Appendix E lists the accelerator (hot keys) for accessing several of the more routinely used

features in MatSeis.

New Features in Matseis 1.8

As a new feature to the user manual we briefly list the new additions to the current release of Mat-

seis. Later, in the tutorial section most of the new features described below will be explained in
1



greater detail and shown with relevant data.

JDBC Database Interface
The JDBC interface allows access to a database through the JAVA programming language

MatSeis Peer-to-Peer Communication (not in public distribution)
Adds the ability for SNL developed tools to interact with one another

View CSS Flatfile Database Tables
Select from a choice of CSS Flatfile tables to view contents. Along with viewing the Origin

table the user can also read in selected origins and chose whether to read arrivals.

System Environmental Variable usage
Use a system environmental variables within configuration files for directory reference

Signal Processing
Array

• Separation of Beam forming techniques: General Beam and Event Beam

• Arrival transfer - transfer an arrival to any element of an array

3-component

• Set existing arrival azimuth and slowness based on results from 3-component FK

Spectrogram

• Animated spectrogram

Power Spectral Density

• Animated PSD

• Selection choice to show animation step 1-6

Measure Tool
Set controls for generating spectrogram and view along with current waveform

Set regional event duration - based on frequency spectrum analysis

Set arrival first motion - Long or Short Period (based on CSS schema fields)

MatSeis Locator
Azimuth and Slowness can now be made location defining

Coverage ellipse calculation now includes model errors read in from LOCSAT format TT files

Infra Tool (* these features not yet available in the general MatSeis.1.8 release)
Automated signal detection routines (*)

• Hough Transform - horizontal line detection method

• Inverse slope - horizontal line detection method

Show/move phase arrival

Write file of processing results - changed format: Human time, epoch time, correlation, fstat,

azimuth and slowness

Read file of processing results and display (waveforms not displayed)

Write detection file - format same as ‘write file for processing results’ (*)
2



Show Theoretical arrival for existing travel times

Buttons to show grid lines in all axes

Hydro Tool
Same MATLAB code as Infra tool but setup for processing hydroacoustic array data. Has all

the same features described in Infra tool section
3
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MatSeis Section 1:
Introduction

Background

As we began to develop the Automated Data Processing (ADP) portion our CTBT Research and

Development Program (CTBTR&D) at Sandia National Laboratories in 1995, a few key needs

were identified. First we required access to a wide variety of sophisticated signal processing tools

to allow us to quickly develop and prototype promising new algorithms. Second, because most of

our data was stored in an Oracle® database, we needed to be able to fetch data from a database

and use these tools on it. Third, to make for a user-friendly environment we wanted to meet both

of these needs with some sort of Graphical User Interface (GUI). While there are many excellent

seismic software packages available which we could have used, we felt that all had significant

shortcomings, even allowing for projected modifications. ARS, Geotool, and dbpick were difficult

for the user to modify and contain limited signal processing libraries. SAC had a richer library of

functionality but supported only basic graphing functions (though this has been improved with

SAC2000). Perhaps most importantly, because none of these are commercial packages, the level

of support for any of them would always be uncertain. For these reasons, we chose to develop our

own software package, now known as MatSeis, which is based on the well-established MAT-

LAB® software package from The Mathworks.

Using MATLAB as a basis has many advantages. It is a popular software package, robust, well

supported, and available on many hardware platforms. In addition, it is an excellent prototyping

environment, with built-in plotting functions and extensive signal processing functionality. Our

data viewing needs could also be met easily with MATLAB graphics functions. In short, MAT-

LAB offered a mature, commercial software package with power and flexibility not available in

the alternatives.

Development History

We developed MatSeis to meet the fore-mentioned needs. MatSeis is a GUI programmed using

MATLAB handle graphics. It provides an interactive time-distance profile display as a platform

for data viewing and manipulation. Common GUI controls are provided such as menus, push-but-

tons, and mouse selections, all written as “m files” in the MATLAB script language, C code inter-

faced to MATLAB through the cmex API and newly added java code through the use of Java

Virtual Machine (JVM).

The initial MatSeis prototype was completed very quickly by taking advantage of MATLAB func-

tionality.The prototype consisted of Oracle database access routines, a data profile display, and

simple plot manipulation controls. Once the power of MatSeis was seen, its functions were

expanded and performance improved to make it a more general seismic data visualization, pro-
4



cessing, and analysis tool. Start-up configuration and system functions such as printing were also

developed. Finally, we improved performance by converting some often-used routines to com-

piled C MEX-files.

MatSeis’ Creators

MatSeis was conceived and created by Mark Harris. The vast majority of the code was written by

Mark, though contributions have also been made by Judy Beiriger, Don Funkhouser, John Mer-

chant, Eric Chael, Matt Olsen, Julian Trujillo, Mitch Withers, Darren Hart and Chris Young.

Many members of the CTBT R&D Team at Sandia Labs have helped refine the organization,

look, and feel of the interface. The current MatSeis maintenance and development team consists

of Eric Chael, Darren Hart, John Merchant and Chris Young.

Typographic Conventions

This manual uses (or tries to!) the following typographical conventions:

Helvetica Commands, function names, screen displays, param-

eter settings within displays.

HELVITICA CAPITALS System variables.

Italics Book titles, names of sections in the manual, com-

puter files and directories.

Bold Key names, module names, menu names, button

names, selectable items

When indicating an option of a pulldown menu, we sometimes use the notation: menu->option. If

there is a option of a submenu you may see: menu->submenu->suboption.

Some functions are linked with “Accelerator” keys (See Appendix E for complete list), which

means they can be invoked by holding down the “control” key and typing another key. Our nota-

tion for this is <ctrl-key>, e.g. <ctrl-f> to use the “f” key to invoke Free Plot.

Selection commands for displayed objects assume that the user has a standard 3-button mouse.

“Left-click” means a single click with the left button, “Center-click” means a single click with the

center button, etc. “Double-click” means two clicks in rapid succession. If no left/right/center is

specified, assume left.
5
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MatSeis Section 2:
System Setup

Platform Requirements

MatSeis was developed on Sun Unix Workstations running the Solaris operating system, but it has

since been ported to many other platforms (SunOS, SGI, IBM-RISC, Windows 95 - 2000, Win-

dows NT and XP, Linux). Porting is generally easy, because the vast majority of MatSeis is writ-

ten as matlab m files, with a small number of routines written in C and Java for improved

performance and portability. The only hard requirements for MatSeis.1.8 are MATLAB® version

6.5 R13 and MATLAB Application Signal Processing Toolbox® (both from The Mathworks
Inc.), a C compiler (only needed if you have to recompile) and Java Virtual Machine (JVM).

Database Requirements

MatSeis works best with a database. A knowledgeable user can enter data in directly, but we do

not recommend this. Currently, MatSeis recognizes three database types: DBMS CSS, CSS Flat-

files and a generic “local” database format, which is included as a starting point to help the user

design a custom interface to their own data format. The new DBMS CSS, replaces CSS Oracle,

since it applies to any brand of database with a JDBC driver. We hope that the database “require-

ment” will not ward off interested users; a database can be as simple as a set of ascii tables. We

provide an example of a CSS3.0 flatfile database in the data/css area. We are also providing newly

constructed test data files in CSS Flatfile format containing examples file structures for MatSeis,

Mag Tool, Infra Tool and Auto Measure.The matseis_test_data.tar.gz file is currently available

from the MatSeis homepage (http://www.nemre.nn.doe.gov/nemre/data/matseis/matseis.html).
These files can be used as templates for constructing a database.

Installation

To install MatSeis:

1. Download the appropriate compressed tar file (e.g. SNL_Tool_Root.tar.gz for UNIX/

LINUX/Windows and map (map is an uncompressed directory) for Windows users) from

the MatSeis homepage and put it in the directory intended to contain this release Mat-

Seis.1.8 distribution.

2. Extract the MatSeis distribution.

For UNIX/LINUX:

   gunzip SNL_Tool_Root.tar.gz | tar -xf

This will create a directory SNL_Tool_Root which will contain four sub-directories (i.e. bin,

kbobs.1.0, matseis.1.8, and test_data). The important directory for those users downloading
6



MatSeis off the web is matseis.1.8 which contains the matlab m-files and a makefile. Note:

hereafter in this manual we will refer to this matseis directory location as

MATSEIS_HOME.

For Windows:

Open the appropriate program (we tested this procedure using WinZip 8.0) for extraction of

SNL_Tool_Root.tar.gz file. Before extraction do the following:

• Open the file extraction program ( e.g. WinZip)

• Click on the Options menu and then select Configuration sub-menu

• Select the Miscellaneous tab

• Unselect the TAR file smart CR/LF conversion checkbox, and click OK
• Use Open Archive and select the SNL_Tool_Root.tar.gz file

• When prompted by a popup question box - Archive contains one file:
SNL_Tool_Root.tar Should WinZip decompress it to a temporary folder and open
it?, select Yes

• Use Extract files from the Archive, select a destination directory (e.g. C:\) and click

the Extract button

These steps are necessary because of problems in the unzipping process, which corrupt the

binary map data files (i.e. *.mat) and make them unreadable to Matlab. This will allow for

quick startup as described below in the Starting MatSeis.1.8 on Windows plat-
forms section.

The extraction process will create a directory SNL_Tool_Root which will contain four sub-

directories (i.e. kbobs.1.0, matseis.1.8, and test_data). The important directory for those

users downloading MatSeis off the web is matseis.1.8 which contains the matlab m-files and

a makefile. Note: hereafter in this manual we will refer to this matseis directory location as

MATSEIS_HOME.

3. For UNIX/LINUX users you will have to add these environmental variables and paths to

your .cshrc file. (Setting this path adds the SNL_TOOL_ROOT bin directory to searched

path for the matseis executable, discussed below in the Startup section).

setenv MATLAB_HOME <Installation directory of Matlab® 6.5 R13 >

set path = ( installation directory/matlab_6.5/bin $path )

setenv SNL_TOOL_ROOT <Installation directory of SNL_Tool_Root>

add path = ($SNL_TOOL_ROOT $path)

**If these are not set the startup scripts (i.e. run_matseis_unix and matseis) described below

will not work as designed.** After this is done, either source the .cshrc (i.e. source .cshrc
<at command line>) or logout and log back in so that these changes can take affect. You can

then test to see if the matseis executable is in your path by using:

which matseis

Which matseis - should return the executable file path in the newly installed
7



SNL_Tool_Root/bin directory.

(e.g. /home/dhart/WEB_USER_RELEASE/SNL_Tool_Root/bin/matseis).

For Windows users the system environmental variables MATLAB_HOME and

SNL_TOOL_ROOT are set when the startup script, run_matseis.cmd is run (found in

SNL_Tool_Root/matseis.1.8/templates/run_scripts directory). These environmental variable

paths will have be changed to match the installed directories of MATLAB and

SNL_Tool_Root.

More on starting MatSeis.1.8 using startup scripts is provided in the next section, which are

separated into different sections by UNIX/LINX and WINDOWS users.

4. Several executable versions of MatSeis are included so you should first try to run it as is. If

matseis is unable to run an error message will be displayed and prompt the user that you do

need to compile the C code. You can do this by executing the command

   make

while in the matseis.1.8 directory. This will compile all MatSeis MEX-files using the cmex
command. The cmex command is provided with MATLAB® and must be configured to

call your native C compiler (refer to MATLAB® documentation). Several of the previously

supplied C code functions have been rewritten in java.

Starting MatSeis.1.8

(Designed for MatSeis Web download Users)

MatSeis can be configured to start up with a custom configuration (e.g. data set, set of travel time

curves, etc.). This is done by setting matseis environment variables (see Appendix D) either by

hand or in a start-up script (discussed later) or by using a configuration file. When MatSeis starts

it first uses default settings, then reads all environment variables from the startup script (if they are

set), and finally reads variables from a configuration file (if one is specified in the startup script).

To avoid confusion, it is important to keep this order of precedence in mind.

Starting Matseis.1.8 on UNIX/LINUX platforms

We provide a script to start MatSeis in the template/run_scripts sub-directory: run_matseis_unix.

The file run_matseis_unix sets several environmental variables (KB_PORT, KB_ADDRESS,
MATSEIS_HOME, KB_HOME and TEST_DATA), copies the MATLAB classpath.txt file, then

adds three java .jar file locations to classpath.txt, starts MATLAB and then MatSeis by calling the

matseis executable in the final line of the file. **You must copy the run_matseis_unix file into the

matseis.1.8 directory and change its name to run_matseis.** Once this have been done you are set

up to use the matseis executable to launch MatSeis from any directory.

Using the executable matseis to start up MatSeis with a custom configuration by setting the envi-

ronment variable MS_CONFIG_FILE to point to a configuration file of their choice. This is done

by setting the directory location of the desired config as the first variable after the matseis execut-

able. Here is an example using the TEST_DATA environmental variable set in the run_matseis
8



script:

matseis $TEST_DATA/matseis/northridge/nr.config

The file matseis is a second type of startup script that expects the configuration file as a command

line argument (e.g. you type “matseis /home/user/test_data/matseis/northridge/config.nr”). This

is probably a better option for installations that serve many users (i.e. this script can be put in a

central location whose path has been added to all user environments).

Starting MatSeis.1.8 on Windows platforms

We provide a script to start MatSeis in the template/run_scripts sub-directory: run_matseis.cmd.

The file run_matseis.cmd sets several environmental variables (SNL_TOOL_ROOT,
MATSEIS_HOME, MATLAB_HOME, KB_PORT, KB_ADDRESS, KB_HOME and

TEST_DATA), copies the MATLAB classpath.txt file, then adds three java .jar file locations to the

classpath.txt file, starts MATLAB and then MatSeis by calling the matseis executable in the final

line of the file. **Remember to edit run_matseis.cmd to reflect machine specific directory

paths.** It is recommended that you make a shortcut to the run_matseis.cmd file onto your Win-

dows desktop. Once this have been done you are set up to use the matseis executable to launch

MatSeis. Simply, double-click on the run_matseis.cmd shortcut and MatSeis will startup.

Configuration

An example of a configuration file is config in the template/config_files sub-directory. MatSeis can

be reconfigured while running by using the Reconfigure option of the File pulldown (see Appen-

dix A), which can be useful if the user is switching between different data sets and/or databases.

In fact, for quickest setup, we recommend storing config files with each data set (use the one in

template as a starting point).

MatSeis is now able to use system environmental variables to expand directory references when

encountered within a matseis configuration file. To explain how this is done look in either file,

run_matseis_unix or run_matseis.cmd, found in the Matseis.1.8/templates/run_scripts directory.

Within these files we set the system environmental variable TEST_DATA:

For run_matseis_unix: setenv TEST_DATA ${SNL_TOOL_ROOT}/test_data

For run_matseis.cmd: set TEST_DATA=%SNL_TOOL_ROOT%\test_data

through the reference of environmental variable SNL_TOOL_ROOT. Once TEST_DATA has

been set it can be used from within the configuration file. Now this can be seen by viewing a con-

figuration file within the supplied test_data (e.g. .../SNL_Tool_Root/test_data/matseis/northridge/

nr.config). Several references are made within the nr.config file:

setenv MS_DB3_DIR           $TEST_DATA/matseis/northridge

setenv MS_OUT_DB3_DIR           $TEST_DATA/matseis/northridge

setenv MS_AUTOMEAS_RECIPE  $TEST_DATA/matseis/northridge/nr.recipe
9



Also, notice the use of the environmental variable: $MATSEIS_HOME.

**One important point to make here is within the config files certain directory paths need to be set

to your local directory structure. Look for ones that end in _DIR or _FILE and change the path, or

file name according to your local structure, or naming convention, respectively.**

The functionality available within MatSeis can be customized with the ms_start.m file. An exam-

ple can be found in the template/run_scripts sub-directory. If this file is in the MatSeis search path

it will automatically be executed. Each user can define their own custom start-up features (i.e.

extra menus, color scheme) using this file. For example, you can include your own matlab direc-

tory in the MatSeis search path, by setting the MATLABPATH environment variable accordingly.
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MatSeis Section 3:
Data Formats

MatSeis was originally developed to interact with an Oracle® CSS3.0 database, but to make the

software more generally useful and access any brand of Database Management System (DBMS)

we have moved to using java database connectivity, or JDBC. This allows an expanded the range

of acceptable databases to accessed by simply requiring ones with a JDBC driver. In this release

we have also adapted reading from the NNSA Schema (revision of CSS 3.0). The NNSA schema,

based on work done by SAIC, takes into account the growing volume of seismic data and the nec-

essary addition of columns for certain fields within CSS tables. The following data formats are

currently supported:

Type Description

DBMS CSS3.0 CSS 3.0 accessed by SQL type query (Input only)

DBMS NNSA Schema Revision of CSS 3.0 accessed by SQL type query

(Input only)

Flatfile CSS3.0 CSS 3.0 flatfile (ASCII) database (Input/Output)

Flatfile NNSA Schema Revision of CSS 3.0 (ASCII) database (Input only)

Local generic template

All data access routines are located in the database directory. E.g. r_tablename.m is the routine

that reads the specified table for the given data format type (1=Local, 2=DBMS CSS, 3=CSS Flat-

file). For data output, MatSeis specifies a separate database, and in the current version only output

to CSS Flat file is supported. To find out more on CSS Schema format see out web site (http://

www.nemre.nn.doe.gov/nemre/data/matseis/matseis.html). Under Documentation and Reports
section, download the SNL report (PDF file) describing NNSA CSS schema used in I/O.

Below we discuss each of the data formats briefly.

1. Local

For those who have other types of database formats, we have provided a generic local for-

mat which can be modified as needed. A set of templates for the example local data format

are in the directory data/local. The files used are:

network: list of networks

origins: list of origin information

stations: list of station information

channels: list of channel information

data: list of data information

An example of raw waveform data is the file 1995260/SP_sz.w.

To use the “Local” data format, the user must set the matseis environmental variables:
11



MS_DATABASE to “LOCAL”

MS_DB1_DIR to the top level directory for the local database

2. DBMS CSS

For this format, the information is accessed from the database using sqlplus style com-

mands. The database tables currently accessed are:

affiliation, amplitude, arrival, assoc, event, instrument, lastid, netmag, network, origin,
origerr, remark, sensor, site, sitechan, stamag, wfdisc, wftag

In this release the new java implementation (JDBC) of the SQL query required the addition

of matseis environmental variables. We have added two new matseis environmental vari-

ables:

MS_DB2_DBDRIVER to the database driver (e.g. oracle.jdbc.OracleDriver)

MS_DB2_DBURL to the driver specific database URL string. (e.g.

jdbc:oracle:thin:@bikinifire:1409:seismic; where

host = bikinifire, port = 1409 and database name =

seismic)

The URL string is specific the database driver being used, since details vary among drivers

the user should review their database vendors documentation (our example shown above is

specific to Oracles classes12.zip driver). For those who are unfamiliar with JDBC, ask the

database management system administrator for support in finding the URL string require-

ments specific to the database driver being used. Then set in the MS_DB2_DBURL string

according to the driver requirements. If the MS_DB2_DBDRIVER is not set on startup, it’s

set to Oracle by default. Here are couple more examples of database types and their associ-

ated URL string requirements:

• For MySQL - jdbc:mysql//<host>:<port>/<database>

• For Access - jdbc:odbc:<data source>

To use the DBMS CSS database format, the user must also set the matseis environment vari-

ables:

MS_DATABASE to “CSS_SQL”

MS_DB2_USERNAME to the database user name.

MS_DB2_PASSWORD to the database password.

Further, we recommend that whenever setting up MatSeis to access a database that the user

first verify that their database environmental variables are setup properly by trying a simple

database query command such as will be formed by MatSeis: e.g. sqlplus username/pass-

word@database_name. If this command does not get you into the database where you can

begin querying, do not bother to try to use MatSeis to access your database: it will not work.

See your database administrator for help before proceeding.

3. Flatfile CSS

The database tables accessed are the same as those used for Oracle database interactions,

but in this case the data comes from flatfiles. Note that the information must be in the speci-
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fied columns (see the NNSA CSS schema it’s available from our website http://
www.nemre.nn.doe.gov/nemre/data/matseis/matseis.html), and that each line must be

the correct length for each table. Failure to verify these is probably the most common trou-

ble encountered when using flat files. Probably the best way to track down problems is to

compare your files with a set that works (see the northridge flatfile “database” in /test_data/
matseis/northridge supplied from the MatSeis web page). Another useful tool has been

added in this release to view CSS Flatfile tables, see CSS Flatfile Table Viewer in Appen-

dix A.

For a CSS flatfile database, the user must set the matseis environment variables:

MS_DATABASE to “CSS_FLATFILE”

MS_DB3_DIR to the top level directory for the flatfile database

Again, this is generally done in the start-up or config file.

Note that the user can actually switch between database types while in a MatSeis session manu-

ally by using the Input Database Setup option of the File pulldown (see Appendix A), or by

reconfiguring.
13
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MatSeis Section 4:
MatSeis Tutorial

Goals

The objective of this tutorial is to get the user started by teaching the basics of reading, writing,

viewing, and processing data using MatSeis. Once these skills have been learned, the user should

be able to learn most of the rest on his/her own. Thus, we do not attempt to describe the use of

every option of every menu in MatSeis. While that would be a worthy goal, it is beyond the

resources currently available to us. Although, we will include some explanation on our new fea-

tures added to MatSeis.1.8.

Starting MatSeis

MatSeis is a MATLAB application, so MATLAB must be running for MatSeis to run. As dis-

cussed earlier in the System Setup Section, we recommend the use of a startup script file, refer

back to the System Setup Section for platform specific instructions. The script file startup has

changed due the new directory structure in this release. We highly recommend taking time to

examine these files to get familiar with our new method for starting MatSeis. There are examples

of run_matseis_unix (or matseis), for Unix/Linux users, and run_matseis.cmd for Windows users,

located in the template/run_scripts directory.

The run_matseis (renamed version run_matseis_unix) file sets the matseis MATLAB_PATH envi-

ronmental variable to include the matseis.1.8 directory and any others the user wants, sets the

matseis environmental variable MS_CONFIG to point to a particular configuration file (more on

this later), and then starts up MATLAB. Please examine this file to see how this is done. Due to

the addition of the matseis.1.8 directory to the MATLAB search path, MATLAB will find and run

startup.m (examine this file too) which will in turn run matseis.m which will launch MatSeis.

Note that with this method the user does not actually have to be running MATLAB from within

the MatSeis directory which is an advantage should the user want to write out any files.

(**Note: If the user wants to take advantage of the new Java implementations of older C code

MATLAB Version 6.5 Release-13 must be used.**) If the MatSeis installation will serve many

users, using the matseis script installed in a central location (e.g. /bin/) might be a better option.

This script takes the config file as a command line parameter and so does not require the user to

edit the script. Using the northridge test_data set config file it would look something like this:

user@machine_name: matseis /home/user/test_data/matseis/northridge/config.nr

If MatSeis crashes or is exited, you may restart it by typing matseis at the MATLAB command

prompt, though depending on the severity of the crash it may be better to exit MATLAB entirely
14



and re-run the run_matseis, or run_matseis.cmd script. This is generally what we do.
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Basic Display Layout

After starting MatSeis, the MatSeis display window will appear on the screen. This window can

be thought of as being composed of five areas: (1) the Waveform Window, (2) the Station/
Channel Information Window, (3) the Origin Window, (4) the Pulldown Menus, and (5) the

Zoom Buttons.

The Waveform Window, where the waveforms are plotted, is in the center of the display. Time is

along the x-axis and distance (in epicentral degrees) is along the y-axis. To the left of the Wave-
form Window is the Station/Channel Information Window which displays station and channel

information for the displayed waveforms. At the top of the Waveform Window is the Origin
Window which shows information for any origins (i.e. orid/evid, that is, the origin id and event

id) read in. At the bottom of the display are the Zoom Buttons which consist of numerous but-

tons used for shifting the viewing reference frame (e.g. zooming and translations). Across the top

of the display are the Pulldown Menus which consist of several pulldown menus (hereafter

“pulldowns”) grouped by use. The leftmost group of pulldowns (File, View) are used to control

the database interaction, manipulate and print the graphics window, launch a few critical tools

(map, free plot, measure tool) and to exit MatSeis. The next group of pulldowns (Orig, Wfm,
Arr, TT) are used for performing various actions on the four defined types of data. The rightmost

waveform window
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origin window
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pulldowns (Meas, SigPro, Corr, Detn, Locn, Mag, Dscrm, Clust, LP, Infra, Hydro) are used to

process and analyze the waveform data. The final pulldowns (AV, Peer Menu, Help) are used to

send MatSeis objects to ArcView, do Peer-to-Peer communication and access the User Manual.

The AV and Peer Menu functionality are not available in the general MatSeis release (and, of

course, it requires that you have ArcView and Tools designed for Intra Tool communication).

Working with Data

We supply test data to use with different tools within MatSeis and are located in

MATSEIS_HOME/test_data. The test_data directory includes three seismic data sets named by

directory: array, galilee and northridge and one infrasound data set. For the tutorial all four data

sets are used, the three are seismic data used in the seismic analysis part of MatSeis and the is

infrasound data to use in conjunction with the Infrasound analysis tool - Infra Tool. More will be

discussed later, as necessary, for the different data types used in this tutorial.

For the seismic section of the tutorial we will use data from 4 stations of the IRIS broadband glo-

bal network for the January 17, 1994 Northridge, California event which is included in the stan-

dard MatSeis release. The data is in CSS 3.0 Flatfile format and can be found in

MATSEIS_HOME/test_data/matseis/northridge. Please refer to the files in this directory as you

work through the tutorial. These files can be used as templates for reformatting the user’s data

files. Note that we include a config file for this data set in the directory. We highly recommend

becoming familiar with the idea and use of config files (as indicated by our next section). They are

very useful to automatically load specific data sets and setting default matseis environmental vari-

ables typically used by the user.

Reconfiguring

We strongly recommend the use of config files to save the user the trouble of having to type in lots

of information to set various parameters. To illustrate their use, we will reconfigure using the con-

fig file provided with the demo data set. Note that this config file could have been pointed to using

the MS_CONFIG environmental variable in the user’s run_matseis script in which case MatSeis

would have come up already configured, with data and travel time curves already read in.

(Remember to modify the directory/file paths in the supplied config files.)

To reconfigure, select the Reconfigure option of the File pulldown menu. You will get a popup

like this:

Click on Config File... and use the resulting popup to set the config file to the nr.config file found

in MATSEIS_HOME/test_data/matseis/northridge. The Config File edit window within the

reconfigure popup should now show the full path to the nr.config file. The Reset Default Config-
17



uration button determines whether or not to use this file as the default configuration file for the

MatSeis session. Go ahead and select this if it is not already. The Delete Existing Data button

will delete any data already read into MatSeis before reconfiguring. In this case it does not matter

whether this button is pushed or not because we have no data in MatSeis yet, but for a case where

you had read in one set of data and wanted to add in another set of data (say another event) with-

out wiping out the first set, you would not want this button set. Once you have made your selec-

tions, click on the Apply button to reconfigure. In this case, the config file specifies that MatSeis

read in an origin (#1), 4 waveforms labeled by station and channel (PASBHZ, NNABHZ,

KIVBHZ, and LBTBBHZ), their associated arrivals, and P and S travel time curves. To see how

this was specified, view the nr.config file and refer to Appendix D for descriptions of all of the

matseis environmental variables which can be set in config files.

Sadly, for the tutorial, we want to teach you how to read data in manually so we will now delete

all of the data that we have just read in! First the origin. Use the Delete option of the Orig pull-

down, select origin #1 (the only choice in this case) and click Apply. You should get prompted

with a popup GUI to ask if you want to delete the associated arrivals too. Choose Yes. Both the

origin and the arrivals should now be gone. All that remains is to delete the waveforms. Use the

Delete->All option of the Wfm pulldown. You should now have a fairly blank looking MatSeis

display, and are ready to begin to learn how to read in data manually, but remember how much

easier it was with the config file!

Database Setup

Data can be read in using the pulldown menus, but first you must set the database parameters

properly if they are not already. Check the database configuration from the File pulldown menu.

Choose the Input Database Setup option. A window will pop-up offering choices of types of

database. Select as appropriate for your system (CSS 3.0 Flatfile for the tutorial) and click the
18



Apply button. A new popup will appear:

Because we reconfigured with the config file for the tutorial data set, all of the parameters should

already be set correctly. For the purposes of the tutorial we will discuss them anyway. For the flat-

file option (as shown above), the user must specify the directory where the database files reside

(MATSEIS_HOME/test_data/matseis/northridge). For flatfile, you must also specify the prefix

for the files/tables (if applicable) and the names of the tables/files (if different from the default

names). For example, the default origin and arrival table names are origin and arrival without

prefixes. If your files are named myfile.origin and myfile.arrival then you must set prefix = myfile,

origin file name = origin, and arrival file name = arrival. For the tutorial the prefix is nr and the

table names are the default names so no changes should need to be made.

Select Apply when you are finished and your database should be setup. If you have difficulty sub-

sequently reading data, you should carefully step through your database setup again and verify

that all of the information is correct.

Note that if you had selected as your input database type CSS 3.0 SQL (i.e. an Oracle database)

you would have had to enter some additional parameters (URL (host, port, database), User-
name, Password, Driver). Once the database parameters have been set, however, the way you

would use MatSeis would be much the same. We have added a Test button to the Input CSS 3.0
SQL Database Setup Window, which looks to see if valid Tables Names exist in the specified

database. Invalid table names are listed at the matlab command line.

Viewing CSS Flatfiles

Because of the past issues with setting up CSS flatfiles for use by MatSeis we have added the abil-

ity to view their contents prior to loading the data contained within them. This can be accessed via
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the View-> CSS FF table Viewer pulldown menu. The supported tables are: Affiliation, Arrival,
Assoc, Event, Gregion, Instrument, Lastid, Netmag, Network, Origerr, Origin, Remark, Sensor,
Site, Sitechan, Sregion, Stamag, and Wfdisc. If the Input Database Setup is correctly set, (i.e. has

valid directory path and prefix set), then simply select a file type and a new window is created

showing the file contents within a listbox. For the tutorial, the available tables are: affiliation,
arrival, assoc, lastid, network, origin, site, sitechan, and wfdisc. Try viewing the nr.arrival file, by

selecting View-> CSSFF table Viewer-> Arrival pulldown menu. Once this is done the MatSeiS
CSS Table Viewer - Arrival Table window will appear.

Along the top are the fields available for the selected file type, within the listbox the data is dis-

played (e.g. 8 arrivals exist in this table). Along the bottom, for a subset of the files are the options

for moving between different halves of the file indicated by << and >> buttons, all file types are

given a Close button. One special table is the Origin, we added the ability to read in selected Ori-

gin from this window. Just open the Origin Table window and selected the origins from the list

provided, then select Read Selected Origin button. Other functionality from this window includes:

reading associated arrivals, zooming to read origins and adding/replacing origins read origins. Try

viewing different tables (i.e. origin or wfdisc).
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Reading Origins

Select the Read option from the Orig pulldown menu and the Origin Read Window will appear.

This display works in two ways. First you read origins from the database to set up a list of origins

to choose from, then you select which of these origins will be read into MatSeis. To set up the list,

enter the various search constraint parameters to the left (e.g. Start Time, End Time, Latitude,
Longitude, etc.) and left-click the Update button. For a flat file database like the northridge tuto-

rial data set, only the time parameters are used. Bracket the time interval by typing in Start Time
and End Time (or alternately, Duration). For the tutorial pick any times which will bracket the

Jan. 17, 1994. E.g try typing 1994 for the Start Time and 1996 for the Stop Time. Note that if the

month, day, and/or time are omitted they will automatically be set to the minimum values. You

can also set the Start Time and End Time to the time interval defined in the waveform window

by selecting the Set Time to Axes button. If you are using an Oracle, or Flatfile database, you can

further refine the query by specifying acceptable values for the Latitude, Longitude, Mb, Ms,

Ml, Depth, etype, and auth. The range in Latitude and Longitude can be set to the region

defined in the Map Tool by selecting the Set to Map Select Box button (see Map Tool tutorial).

Once you have the parameters set, left-click on the Update button to query the database for all

origins in the database in this range.

All of the origins in the range should now show up in a list to the right (see the figure above for an

example). In our case, there should only be one (the 1/17/1994 Northridge event). If no origins are

displayed there is probably something wrong with the Directory value in your database setup. To

be safe, make sure to use the absolute path name (e.g. MATSEIS_HOME/test_data/matseis/
northridge).

Once the origins are read from the database, they can be selected from the listbox for display in
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MatSeis. You can select All, None or select individual origins by clicking the buttons next to the

orids (origin ID numbers). Several sorting options are available to aid in finding origins of inter-

est. Selecting the button at the top of each column (Origin, Event, Time, Lat, Lon, Depth, Mb)

will sort by that field; selecting the +/- button will reverse the order of the sort. For the tutorial,

select the single origin shown and proceed.

Once the origins have been selected you can specify further options. Add or Replace determine

whether the selected origins will be added to any already in MatSeis or will replace them. In this

case there are no pre-existing origins so either can be chosen. Read Arrivals will cause any arriv-

als associated with the selected origins to be read as well. For the tutorial do not select this as we

want to show how to read arrivals separately. Similarly, Read Waveforms will cause all wave-

forms associated with the selected origins to be read in (For this release we have disabled this fea-

ture). Zoom to Origins will zoom the time interval of the display to bracket all of the selected

origins (in this case just one). Select this option.

When all origins to be displayed are selected and the options are set, select Apply. The orids

(unique ID numbers) for the selected origins should now be visible in the Origin Window of

MatSeis.

Note that there is nothing (other than common sense!) to prevent one from reading the same origin

into MatSeis over and over again. There is currently no logic to check and see if the origin already

exists so MatSeis will simply add it again and again if you chose Add instead of Replace. Thus

unless you are certain that you want to add origins to those already in MatSeis, we recommend

using Replace.

Origin Functions and Properties

Origins are selectable objects with a variety of applicable functions and with properties which can

be displayed and edited. The full set of origin functions is accessed through the Orig pull-down

(Appendix A), but a limited set can be accessed directly by right-clicking on the orid in the Origin
Window to invoke the Origin Functions Pop-up (see Appendix B).

Select will select the origin, Edit will access origin properties via another pop-up (described

below), Raise will move it in front of other orids (if they overlap), Lower will move it behind,

Erase will hide the origin from view but not from memory, Delete will remove the origin from

view and from MatSeis, and Cancel will dismiss the pop-up.

First choose Select to select this origin (this can also be done by left-clicking while the mouse

cursor is over the orid). When an origin is "Selected" in MatSeis the origin ID/event ID will be

colored red.
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Then Choose Edit to bring up the Origin Edit Window.

This window can be used to review or edit any of the origin properties (e.g. if you wanted to add a

comment). All of the fields are editable. Select Apply after changes have been made to save them

in MatSeis or Cancel if no changes are desired. For the tutorial we have no changes so cancel out

of both the Origin Edit Window and the Origin Functions Pop-up. Before you proceed to the

next section make sure that orid 1 (the Northridge event) is selected. Note: only one origin can be

selected at a time. In some instances you may want to create a new origin as one would in building

an event. For this case we offer the ability to set the origins latitude and longitude as the center of

the Map Tool select box, simply click on the Set to Map Select Box button. This is a quick

method for associating a new origin to a geographic region.

If you are working with a large number of origins it may be difficult to find the origin you want in

the Origin Window. In this case, it is easier to select an origin using the Select option of the Orig
pulldown. This will bring up a selectable list of all the origins currently in memory, a GUI like the
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following will come up:

Choose the one you want and then choose Apply to select it in the MatSeis Origin Window. Note

that as with the Origin Read Window, the information here can also be sorted by any of the col-

umns. For the tutorial, go ahead and select the origin 1, the only one in the list.

One feature to try is the group select. This is done by selecting the first or last origin, arrival, TT

phase, or waveform from a sorted list of several. Then press-and-hold ‘shift’ on your keyboard

and go to the end or beginning of the list of items to included in the selection process and click on

its radio button. The desired items should now be selected. Most of the gui pop-up windows fea-

ture this capability to select a number of items quickly. Try this later in the tutorial, when the

opportunity arises.

A new feature to MatSeis is the CSS FF Table Viewer located under the View menu. This allows

user to view their CSS flatfiles if problems arise when trying to load data. We also added the abil-

ity to load Origins from the View -> CSS FF Table Viewer -> Origins menu selection. Simply,

select the desired origins listed in the listbox window and select the Read Selected Origins but-

ton. Try viewing the Arrival, Assoc, Site, or Sitechan tables from this menu to see how the table

information is displayed. When << or >> button are presented, the tables are to long for display in

a single window so they allow for scrolling between two sections of the table. Only one table can

be viewed at a time, and an error ‘Beep’ will be given if a table window is already open and a sec-

ond table window is selected for display.

Reading Travel-time Curves

We want to read waveform data, but first we will show how to read travel-time data because the

travel-time curves are very useful for setting the time interval for reading waveforms. Select the
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Read option from the TT pulldown and the Travel-time Read Window will appear.

Select Travel-time Format to pop-up a list of the supported formats (LocSAT/EvLoc, ASCII
Matrix, Master Image). For the tutorial we will use LocSAT/EvLoc because a large set of

IASP91 tables in the LocSAT format are included in the standard MatSeis release. For most users

who want to set up their own tables, however, ASCII Matrix is probably the most useful (and intu-

itive). Next specify the Travel-time Directory where the travel-time tables can be found

(MATSEIS_HOME/data/iasp91) and the File Prefix of the travel time tables (iasp91).

If all of the above are valid, a list of Phases should now appear to the right which will include an

entry for every table in the specified Travel-time Table Directory. If it does not, check the set-

tings again carefully. Make sure that the paths and prefixes correspond to actual locations and

files. To select curves to read into MatSeis, use Select All or select phases individually (Try to

group select some!). For the tutorial select P, S, and Lg. Select Add to add the travel-times to any

already in memory or Replace to clear. In this case, choose Replace in case any travel time curves

have already been set up in MatSeis so we do not get duplicates. Select Apply and the travel-time

curves will be read and displayed. If you find picking a few phases from the large list cumbersome

(we do!) we recommend setting the travtime phases in the config file so that they are automati-

cally loaded on startup or reconfigure.

Displaying Travel-time Curves

If the Northridge origin is selected, the travel time curves (shown in the Waveform Window)

should be tied to that origin. The curves may be difficult to see because of the time scale and/or

their color. To change the color of the travel-time curves use the Color option from the TT pull-

down. Choose random to get different colors for each curve. To get a better view of the selected

origin, left-click the full button in the Zoom Buttons area. This will zoom the waveform window

to bracket the travel-time curves that are currently shown.
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The display should now look something like this.

Travel-time Curve Functions and Properties

The full set of travel-time functions is accessed via the TT pulldown (Appendix A) but a limited

set can be accessed directly by right-clicking on one of the curves to invoke the Travel-time
Curve Functions/Properties Pop-up (Appendix B). This menu mixes functions with proper-

ties. Align will vertically align the display on the curve, Color sets the color of the curve, Width
sets the width in seconds, Slowness will show the slowness information for the curve at the point

where it was clicked on (try this!), Raise will put the curve in front of any others, Lower will put

it behind, Erase will remove the curve from the display but not from memory, Delete will remove

the curve from display and memory, and Cancel will dismiss the pop-up. Other functionally fea-

tures include; left-clicking on a TT curves to display the associated phase arrival, double left

clicking will align on the TT curve and middle clicking on a TT curve opens popup window Slow-
ness giving the Phase, Depth, Distance and Slowness at the distance clicked.

For the tutorial we want to align on P, so select Align. You can also align by using the Time
Alignment option of the View pulldown (select Phase and a pop-up will appear with a list of the

displayed phases to choose from). Note that once you are aligned on a phase, when you bring up

the popup for that curve, instead of Align, you will have an Unalign option. Practice aligning/

unaligning on each of the curves shown (to get a better view of the T-T curves, left-click the full
button in the Zoom Buttons area). For the tutorial, we will assume that the display is aligned on
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P, so make sure that you are in this mode before proceeding. Note however, that none of the rest of

the discussion requires that the Waveform Display be in align mode: you should use whichever

mode works best for the task at hand.

Changing the Viewing Reference Frame

We are nearly ready to read waveform data but as we shall see we can make our waveform request

even more efficient by first zooming our display to bracket the portion of waveforms needed for

the task at hand. Let us assume that for our selected event we are interested in picking P arrivals

for stations closer than 100 degrees. To do this we only need to read in a small amount of wave-

form data around the predicted time of the P arrival.

To setup our waveform display we need to understand the rest of the Zoom Buttons (Appendix

C) displayed along the bottom of the MatSeis display. The first group (ZOOM: undo, full, ori-
gins, data) are general zoom utilities. Undo simply reverts the display to whatever it was before

the last zoom action. Zoom actions are stacked so selecting undo multiple times will continue to

recall subsequent displays (i.e. they are fetched from a stack). Full, as we have seen, will zoom to

a view of a selected origin just wide enough to show all of the travel time curves read in. Origins
will zoom to a view of all origins selected for display, whether they span a range of seconds or a

range of years. Data will zoom to show all waveform and arrival data currently in MatSeis and is

most useful when no origin is selected. Note that this option can lead to considerable confusion

when you are working with waveforms for events widely separated in time. The Data zoom will

zoom to a window big enough to span all of the data which may make none of the waveforms

readily visible -- if the events span several years than so will the display. The easiest way to notice

this has happened is to look at the time scale along the bottom of the Waveform Window.

The second group (IN: XY, X, or Y) are all zoom in functions. To zoom in, select the appropriate

button and a cross cursor will appear. Left-click once to choose one corner of the zoom area and

hold and drag to define the other corner. Note that the method is the same whether defining a two-

dimensional zoom (XY) or a one-dimensional zoom (X or Y). However, for a one-dimensional

zoom the other rectangle dimension (y or x) will have no effect on the zoom. This style of drag-

box (also known as a “rubber band box”) is used throughout MatSeis, as we shall see.

The third group (OUT: XY, X, or Y) are zoom out functions. To zoom out, simply select the

appropriate button. The amount of zoom out is preset.

The fourth (DRAG: XY, X, or Y) and fifth (MOVE: up, down, left, right) groups are translation

functions. MOVE is simpler but less flexible. Simply select one of the buttons and the viewing

frame of reference will shift by a preset amount in the corresponding direction. The drag buttons

are much more precise (and more useful). Select one of the buttons and the cross-cursor will

appear. Click the left mouse button on a feature in the current display and hold and drag to the

spot where the feature should be in the new display.

The zoom IN, OUT, DRAG and UNDO features can also be accessed by right-clicking within the

Waveform Window for XY mode. Origin Window for X mode, and Station/Channel Window
for Y mode.

The MatSeis Waveform Window alignment is accessed by right-clicking within either the

Waveform Window, Origin Window, or Station/Channel Window. The three types of window
27



alignment are Origins, Travel Times, and Waveforms. Try right-clicking within the different win-

dows to see where the different window alignment features are located. (Waveform Window -

Waveforms, Travel Times and Origins. Origin Window - Origins. Station/Channel Window -

Waveforms).

Become familiar with the use of the various zoom buttons by experimenting with the currently

displayed travel-time curves for the selected origin. Remember to use undo to revert to the previ-

ous display. Now, using any combination of zoom functions you like and with the display aligned

on P, zoom in to a window ~10 minutes wide centered on the P curve with the Y axis spanning

distances from 0 to 100 degrees.

The display should look something like this.

Reading Waveforms

We are now ready to read waveform data. Select the Read option from the Wfm pulldown

(Appendix A) and the Waveform Read Window will appear. Begin by specifying the Network.

If there is no network specified, then all of the stations will be shown. However, for the purposes

of the tutorial we want to show how network information is used, so read on. You can either type

the network name directly in or click on Network and a popup with all of the networks defined in

the network table will be shown. In this case there should be only one: IRIS. Select it. Once the
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network is specified, all of the Stations and Channels in that network will be displayed (linking is

done through the affiliation table, try viewing the affiliation table using the CSS FF Table
Viewer!).

Select All stations and channels or choose a specific set. Again, the lists can be sorted by the dif-

ferent fields and the sorting can be reversed using the +/- buttons. For the tutorial, select all sta-

tions within 105 degrees of the origin (i.e. distance < 105) and choose the BHZ channel only.

Bracket the time interval by typing in Start Time and Duration (or Stop Time) or use the time

interval defined in the waveform window by selecting the Set Time to Axes button. Note, how-

ever, that this last step is unnecessary unless you change the Waveform Window while the

Waveform Read Window is up: by default the time interval will come up set to the limits

defined by the MatSeis Waveform Window. This is why we went to the trouble of setting up the

Waveform Window before reading in any waveforms: by aligning on the P travel-time curve, and

using the various zoom functions to set the window, we have made it unnecessary to type in the

time limits. Note that one should always seek to read in as little waveform data as possible, as the

more data that is in MatSeis the poorer the performance will be.

For an Oracle database, statype and refsta allow you to further refine the stations to choose from

assuming these fields have been properly populated in the site table. The parameters have no

effect for a flatfile database (like the tutorial set).

Add will add the waveforms to those already in memory, while Replace will replace the wave-

forms already read in memory. Location Only will plot baselines at the correct epicentral dis-

tances rather than actually reading in data (this can be useful in some unusual situations!).

Demean Waveforms will remove the mean from the waveforms before they are plotted (useful

for broadband data). Zoom to Data will automatically zoom the display to bracket the waveforms

(if the waveforms are being added to some already in MatSeis, then the bracketing will be for all

of the waveforms). For the tutorial choose Add and Demean Waveforms only.

When the stations and channels are selected and the options are set, select Apply and the wave-
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forms will be read from the database and displayed.

The display should now look something like this.

Waveform Scaling

Counter to what would be expected for stations spanning such a wide distance range, the wave-

forms appear to be approximately equal in amplitude, but this is only because the default wave-

form scaling is automatic, i.e. all waveforms are scaled so that their maximum amplitudes are

equal. To see the true relative scaling, select the Scaling option of the Wfm pulldown and choose

either Global Fixed or On-screen Fixed. Fixed means that the maximum amplitudes of all wave-

forms are scaled relative to the maximum amplitude of the largest waveform (in this case the one

at station PAS). On-screen means that the maximum amplitudes used come from the portions of

the waveforms shown on the screen, global means that they come from the complete waveforms,

whether on screen or not. Note that for fixed scaling the waveforms at the two further stations

become essentially flat lines, which is as expected given how much farther away they are than

PAS. For the tutorial we want to see the shapes of all of the waveforms, so go back to the Wfm
pulldown, choose the Scaling option, and choose On-screen Automatic.

Waveform Functions and Properties

The full set of waveform functions is accessed via the Wfm pulldown but a limited set can be

accessed directly by right-clicking on one of the station names shown in the Station Information
30



Window, or the waveforms in the Waveform Window to invoke the Station-Channel/Wave-
form Information Pop-up (Appendix B):

Select will select the waveform, Amp will change the amplitude, Color will change the color,

Edit will access waveform properties via another pop-up described below, Add Arrival will add

an arrival at the cursor point where the left-click was executed using the Default Phase set in the

Arr pulldown, Raise will move it in front of other waveforms (if they overlap), Lower will move

it behind, Erase will hide the waveform from view but not from memory, Delete will remove the

waveform from view and from memory, and Cancel will dismiss the pop-up.

Choose Edit to bring up the Waveform Edit Window (Appendix B). This window shows proper-

ties for both the waveform and the station/channel. All of the fields are editable. Amplitude, Off-
set (vertical), Clip Level, Color, Line Style, and Line Width will all affect the way the

waveform is displayed. Select Apply after changes have been made to save them or Cancel if no

changes are desired. For the tutorial we have no changes, so select Cancel.

Selecting Waveforms

Waveforms can be selected using the option in the Station-Channel/Waveform Pop-up, but this

is generally the least used method. To quickly select a single waveform or a small number of

waveforms from the Waveform Window, type <ctrl-w> and you will get a cross cursor, ala the

zoom commands. Simply drag a box to surround the waveforms to be selected (note that the box
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does not need to encompass the ends of the waveforms, only the vertical extent is important here).

The station/channel and waveform will change from white (or specified color) to red when the

waveform is selected. Practice selecting groups of waveforms. To unselect waveforms, just draw a

box that does not contain any or type <ctrl-n>.Another way to select single waveforms is by left-

clicking on the station name shown in the Station Information Window, or the waveforms in the

Waveform Window. To unselect a previously selected waveform just left-click a second time on

either the station name or waveform.

When a more restrictive selection is required, the Select->From List... option of the Wfm pull-

down is generally used. This will bring up a selectable list which can be sorted in many ways (e.g.

by distance, by channel type). Note that the distances are epicentral distances for the currently

selected origin. With this list one could, for example, quickly and easily select the BHZ channels

for all of the regional distance stations for an event. Experiment with selecting, unselecting and

changing the sorting of the list.

A full list (Station, Channel, Start Time, Latitude, Longitude, Elevation, Amplitude, Offset, Clip

Level, Color, Line Style, and Line Width) of waveform information can be accessed by middle-

clicking on a waveform in the Waveform Window, or the station/channel name in the Station
Information Window. All except two fields are editable, with Color and Line Style being popup

menus.

Reading Arrivals

For the tutorial we will pick our own arrivals rather than read them in. To read in arrivals from an

arrival table, select the Read option from the Arr pulldown (Appendix A) and the Arrival Read
Window will appear.

This display is very similar to the Origin Read Window. First you read arrivals from the database

using the Update button, then you select which of these arrivals will be brought in to MatSeis.

When the arrivals are selected and the options are set (Add or Replace), select Apply. If you want

to try to read in the arrivals for the demo data set, go ahead. But after you have done this, delete

them before proceeding. To do this use <ctrl-a> and drag a box to select the arrivals, then type

<ctrl-g> to delete them. See the Select option of the Arr pulldown for more select options, and

the Delete option of the Arr pulldown for more delete options.
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Picking Arrivals

The waveform display should now be fairly well set up to pick arrivals. If you don’t mind cheating

and want to pick a lot of arrivals fast, select the Pick Travel-times option from the Arr pulldown.

This utility will make picks for all travel-time curve phases displayed on all waveforms displayed

at the theoretical arrival times (i.e. where the travel-time curves cross the baselines of the wave-

forms). One can also specify to apply an elevation correction if the approximate surface velocity

is known, just edit the necessary phase values. This feature was added for creating synthetic data

sets for testing; we do not advocate its use!

To pick arrivals a little more carefully, first use the zoom buttons to zoom in or out to get a better

view of the waveforms as needed. To pick an arrival first set the default phase type by selecting

the Default Phase option of the Arr pulldown. A pop-up will appear from which the desired

phase can be selected or typed-in. Note that the list of choices corresponds to the travel time

curves that have been read in. For the tutorial, choose P from list by selecting Apply (which will

dismiss the list), then make this the default phase by selecting Apply again from the default phase

popup.

To pick an arrival, right-click on the waveform at the point you want to add the arrival and the

waveform popup will appear. Select the Add Arrival option and a pick will be added. Note that

the arrival will appear with the default phase name and will be red indicating that it is associated

with the current origin (unassociated arrivals are white and associated selected arrivals are bright

red). Pick P arrivals for all three stations, but do not worry about any errors; we will show how to

fix these (e.g. retime, delete) in the next section.
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Your waveform display should now look something like this.

Arrival Functions and Properties

The full set of arrival functions are accessed via the Arr pulldown, but a limited set can be

accessed by right-clicking on the arrival to invoke the Arrival Function Pop-up (Appendix B):
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Try this on one of the arrivals:

Associate/unassociate will associate or unassociate the arrival with the selected origin (double-

left clicking will also associate/unassociate arrivals), Phase will change the phase name, Move is

used for retiming, Edit will access the arrival properties via a pop-up described below, Raise will

move the arrival in front of any others, Lower will put it behind, Erase will remove the arrival

from display but not from memory, Delete will remove the arrival from display and memory, and

Cancel will dismiss the pop-up.

Choose Edit to bring up the Arrival Edit Window (Appendix B), also accessed by middle-click-

ing on a arrival. This window can be used to review or edit any of the arrival properties, which are

actually a combination of the arrival and assoc CSS3.0 tables. All of the fields are editable. Select

Apply after changes have been made to save them or Cancel if no changes are desired. For the

tutorial we have no changes so select Cancel.

To retime an arrival, select Move. A cross cursor will appear. Move the cursor to the new location

and left-click to mark the new time. The arrival will move to the new time.

Using what you have learned above, retime all picks and delete any extras. Add picks for S and

Lg. You can either change the default phase before picking these or pick them as P’s and then

rename them. Note that when you rename them, you can type in whatever you like (you are not

limited to the phases of the travel time curves).
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Measure Tool

Though you can pick and retime arrivals within the MatSeis Waveform Window as described

above, a better way to do it is using Measure Tool, which is found under the Meas, or View pull-

downs. Measure Tool can be used in several ways. To make picks for a single waveform, select

that waveform before launching Measure Tool. To make picks for all of the waveforms for an

event, unselect all waveforms before launching Measure Tool. For the tutorial, let’s work on the

whole event so unselect all of the waveforms by using <ctrl-w> and dragging a box which does

NOT contain any waveforms (or using the Select->None option of the Wfm pulldown, which can

be triggered using <ctrl-n>). Then type <ctrl-m> to launch Measure Tool, or either method men-

tioned above.

Several new feature have been added to Measure Tool, the major one is display a spectrogram in a

separate axis window just above the waveform. It should be noted that depending on the parame-

ters used to make the spectrogram that either low time, or frequency resolution may result. We

suggest getting familiar with the spectrogram settings and their effect on generating spectrograms.

We suggest setting the low frequency to 0.4, for the tutorial.
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Near the top of the tool is a list of the waveforms for the event. As we have seen for other types of

lists, you can sort on any of the quantities on the list by clicking on the header for that quantity

(e.g. Distance), and you can reverse the order of sorting by clicking on the + button to change to -

or vice versa. Sort by distance and then select the closest waveform (PAS). The waveform for

PAS will appear in the waveform window. This display should look something like that shown

above. Note that the units for the waveform are labelled on the y axis. By definition these should

be nm because the raw data, which is in counts, is multiplied by the calib field from the wfdisc

table when the data is read into matseis, and calib is defined to have units of nm/count. Of course

these units are only truly correct for the calper (calibration period, also given in the wfdisc) corre-

sponding to the calib values unless the waveform has had the instrument response deconvolved.

The red bar is the theoretical arrival time for the currently selected phase (phase that’s aligned in

the MatSeis Waveform Window, in our case the P) as shown in the Phase popup near the top.

The list of possible phases comes from the travel time curves in MatSeis. Thus, for the tutorial P
is the current phase. To select another phase click on the current phase (P) in the Phase popup

near the top and a popup will appear. Select either S, or LR, and then Apply. The phase should

now be switched to the newly selected phase. Referring back to the Waveform Window, it should

now be centered on theoretical phase arrival of the previously selected phase (either S, or LR, in

our case). To continue with the tutorial, make the P the current phase. The vertical green bar (or

magenta bar in the spectrogram window) is the P pick (assuming you have made one in the Mat-

Seis Waveform Window), and it includes an horizontal error bar. To retime the arrival, simply

left click and hold on the picked arrival and move it, then release the button when you have the

pick at the desired time (the right and center mouse buttons work the same way). You can adjust

the error bar in the same fashion, by grabbing either side of the error bar and stretching/compress-

ing as much as desired. Notice that the Time and Std Dev displays in the lower left change as

these are adjusted. The Zoom and Drag buttons for the waveform display work much the same as

for the MatSeis Waveform Window except that these are “sticky” (i.e. they stay selected until

you unselect them. When using the Zoom features, clicking the right mouse button in the wave-

form window zooms out a preset amount. Note that if you zoom in or out the Lag and Duration
values will change. You can also type these in directly and the waveform window will change

accordingly. If you prefer not to work with Lag and Duration you can toggle these to Start time

and Stop time. The Scale buttons control whether or not the waveform is automatically scaled

whenever you shift/zoom. The True Time button alternates between true time and time relative

to the picked time (try it!). Use whichever of these buttons you like to help you refine both the

pick and error bar for PAS.

To move on to the next station (NNA) there are a couple of options. First, you could go back to the

list at the top and select NNA. Alternatively, you can press the >> button in the Arrival section of

the tool to move to the next waveform in the list. (<< will shift back to the previous waveform, if

there is one). Try all of these to switch back and forth between waveforms. Once you have NNA

displayed, we can add a pick (if NNA did not have one already). To do this simply choose the +
button in the Arrival section. This will change the cursor to a cross-hairs in the waveform win-

dow, and you can now click wherever you want the new pick to be. Add a pick in this manner, and

adjust the error bars to be appropriate for the resolution of your pick. To delete an arrival, just

push the - button. To review (and edit if you wish) all of the properties for an arrival select the

Ed... button. The Save to Arr. Amp. popup lets you choose which type of measurement

(described below) will be saved to the amp field of the arrival (only one value can be stored in this
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field). This is important because the Magnitude Tool will base its calculations on this amp field.

Using what you have learned, move on to the KIV waveform and add a P pick. Let us now make

an amplitude measurement to go with the pick. (Note: you cannot make amplitude measurements

unless you have an arrival, so make sure you have one for KIV before proceeding!). This is done

using the controls in the area labelled Measurement. You can choose the type of measurement

using the popup menu labeled Meas. Type. We will choose Zero-Peak for the tutorial. To make

the measurement, choose the + button in the Measurement section, and the cursor will change to

a cross in the waveform window. Simply drag a box (ala the zoom functions) to encompass the

maximum peak (or trough) that you want to measure. Two boxes will appear. A gray one showing

the entire measurement window and a pink one showing the measurement itself. The amplitude

and period (in this case twice the length of the measurement box) are shown in the labelled Amp
and Per areas below.

If you missed the peak you wanted, you can slide or resize the measurement box by clicking and

holding on either the middle or the side of the gray measurement window and moving it. Notice
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that after you move the window, the pink box automatically snaps to show the new peak and that

the Amp and Per values change. If you want to delete the measurement, push the - button and the

gray measurement window and pink box will disappear. For measurements, the >> button will

move to the next type of measurement from the popup menu and << will move to the previous

one. You should be able to make any of the measurement types so long as you do not try to correct

for instrument response (in the demo data set the instrument and sensor tables were not set up and

no instrument response files are provided for these waveforms). Using what you have learned, go

back and make Zero-Peak measurements for NNA and PAS. When you are finished, select Apply
to save the measurements and new picks back to MatSeis. If the amplitude measurement to be

saved with the arrival is either sub-noise or clipped and will be used for a maximum likelihood

magnitude calculation, then the appropriate radio button in the arrival section should be used.

To assist in the picking of arrivals on waveforms with low SNR a filtering tool has been added to

Measure Tool. Within the Filter window some basic filtering parameters are given and should be

set before applying the filter. Different filter types (Bessel, Butterworth, Chevbyshev I, Chevby-

shev II, etc.) are selected from the pulldown menu next to Type. The pulldown menu next to

Band Type lists the basic band types (i.e. High Pass, Low Pass, Band Pass and Band Stop) to

choose from. The two editable windows next to Cutoff are to enter the cutoff frequency, or fre-

quencies, in Hertz, that will be applied by the selected filter. Once the filter type, band type, cutoff

frequencies and other necessary parameters are set the Filter radio button just above the Filter
window turns on and off the selected filter. Scrolling through the waveforms with the filter radio

button on, filters each waveform by the selected filtering parameters. For more on filtering see

Appendix B, under SigPro. For the tutorial, select Cancel from the lower left, therefore closing

Measure Tool.

We have added an auto measurement tool for those users who repeatedly make measurements for

amplitude/period based magnitude calculations. To launch this tool use Meas->Auto Measure...
A popup gui appears and prompts the user to select a Recipe File. The Recipe File, an example

shown below, defines the parameters used to make the amplitude/period measurements. The fields

are station (STA), channel (CHAN), phase (PHA), lower cutoff frequency (FLO), upper cutoff

frequency (FHI), number of filter poles (FPLS), offset time 1 (OFF1), group velocity 1 (GV1),

offset time 2 (OFF2), group velocity 2 (GV2), type of amplitude measurement (MEAS_TYPE),

instrument response correction (IC). For Auto Measure to correctly work, follow these rules.

Travel time curves must be loaded in Matseis for the phases specified in the Recipe File. In our

case only the P phase. Positive values for filtering parameters FLO and FHI, turn filtering on. In

our example, filtering is turned off. Both GV1 and GV2 can be obtained from Measure Tool. Go

to the gray Waveforms Window within Measure Tool. From the Lag pulldown menu select

GV1, and GV2 from the Duration pulldown menu, and there associated values are posted. The

offsets should be given in seconds. Currently, only three measurement types are available with the

Auto Measure tool: Peak-Peak, Zero-Peak, and RMS. A value of 1 or 0 under IC will either use

or not use the instrument response corrections. Let’s try the Auto Measure tool.
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Start by clicking on Auto Measure, as described above, from under Meas. Now click on the Rec-
ipe File area within the gui. Select the nr.recipe file located in MATSEIS_HOME/test_data/mat-
seis/northridge, and click Apply. Check your Matlab command window to see that measurements

were made. Now to see the measurements, open Measure tool if you don’t have one already

open. Select the P phase, station NNA, and, Zero-Peak measurement type. Within the waveform

window you should see that a measurement was made. Check to see if the other measurements

were made.

Other new feature to Measure Tool is the ability to determine either short or long period first

motion of an arrival pick. We use the arrival time and right standard deviation to extract the wave-

form data and then use inverse theory to determine the best fit line to that data. Then based on the

slope of the best fit line, the first motion value is set and saved by Measure Tool. Try the new first

motion tool by selecting Set First Motion LP from the popup menu in the Measurement section
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of Measure Tool. The First Motion Long Period window is shown below:

From either First Motion GUI, Long or Short period, the first motion is set along with the quality.

We provide two types of inversion methods to solve for the best fit line to the data, least square L-

2 norm and L-1 norm techniques. The least squares L-2 norm is used as default, but can be

changed and the first motion is recalculated. The frequency cutoff can be adjusted and the first

motion recalculated based on users experience and data set.

Two other new features, Set DUR and Move DUR were designed to be used on regional data sets.

They assist in the generation of the duration data used to calculate an events magnitude based on

duration time (i.e. P-DUR) of the recorded event. This function requires that an arrival be set prior

to selecting the Set DUR button. By selecting the Set DUR button the cursor turns to a cross and

the user should select a pre-event window from within the spectrogram axis. The pre-event win-

dow is then averaged with respect to frequency by the number of time bins captured in the win-

dow. Then a search is done, following the arrival pick, to find the first region in the spectrogram

which is within 10% of the set window and creates an arrival labeled DUR. Each frequency bin is

considered in this process, hence no averaging is done with respect to the vertical frequency axis.

If the calculated duration (i.e. event coda drops below SNR) is consider incorrect then the user can

use the Move DUR button, which will turn the DUR arrival bright green and the user can click

and drag the DUR arrival to the desired location.

This completes the basic tutorial on Measure Tool. Were more origins read in to MatSeis, you

could switch to another origin by clicking on the Origin popup at the upper left and choosing the

next one you wanted to work on. The Send to Tools buttons in the upper right are for sending

added/modified values to the MS Locator Tool, LocSAT Tool, Dendro Tool and the Magnitude
Tool, which will be discussed in the next sections.
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Locating Events

MatSeis now has its own event location algorithm. The algorithm used is based on Ballard, 2002,

which describes the Levenberg-Marquardt least squares inversion technique. Two new features

added to the MS Locator Tool. The first is the use of azimuth and slowness data in determining

an event location in the least-squares since. The second being the use of Theoretical travel-time

model error when determine the total error weighting applied during the iterative location inver-

sion process.

The MS Locator Tool can be launched from the Locn pulldown, or from Measure Tool if you

already have that up. We will do it the latter way for the tutorial.Using Measure Tool, pick P

arrivals and set reasonable standard deviations for the 4 stations. Now we should be ready to

locate. Click on the MS Locator Tool button in the Send to Tools area of Measure Tool. Pres-

ently the MS Locator Tool should popup.

This interface has five sections of controls and parameters. We will begin in the upper left, with

the Status line. Upon opening the MS locator tool the status line should be blank. When locating

an event, this line will be updated to tell you whether or not the solution converged. The MatSeis
Update button in the upper right will re-read data from MatSeis in the case that new origins have

been added since the MS Locator Tool was brought up, or if arrivals have been added and/or

retimed.

Below the status line is the origin information section. The Origin ID shows the current orid’s

information, which should read “1” for our origin. This shows which of the origins in MatSeis we

are currently displaying information for. To change the origin, click on the button and a popup

GUI will allow you to choose from the complete set of origins. Try this, but in our case, there is
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just one (#1), and it should be selected, but if there were more than one origin in MatSeis, all

would be listed here and the selection of the radio button to the left of each determines which one

will be located when you run the locator (done by clicking on the Locate button at the bottom

left). Other origin information includes the origin epoch time (Origin Time), root mean square of

the residual travel times normalized by the arrival standard deviation (RMS), latitude (Lat), lon-

gitude (Lon), depth (Depth), body wave magnitude (Mb), the number of associated phases (Nas-
soc) and the number of defining phases (Ndef).

Next, is the Error Info section. All the origin error information is displayed to the right of this

button for the indicated origin, and these values would change if you were to pick another origin.

The location solution can be based on either the confidence or coverage criteria. The Error Info is

computed for three levels of solution confidence 68, 90 and 95%, giving the error ellipse strike,

semi-major axis (SemiMaj), semi-minor axis (SemiMin), standard deviation in depth (SDepth)

and standard deviation in TT residual (STime).

We will now review the arrivals being used to locate this event. To see these, click on the Arriv-
als... button on the row labeled “Phase List”. Notice that by default, all phases for which you have

picks will be in this list. If you only want to look at certain phases you can edit this list accord-

ingly. You should now see another popup list of the arrival information:

This list should hopefully be fairly straightforward. There is a row for each arrival picked and the

display is divided into four segments left to right. The first gives the general information for the

arrival (ID, distance, station channel, phase). Note that you can sort the list by any of these by

clicking on the corresponding column heading. Try sorting by distance. The next area shows the

time pick information: time, residual (obs. - theoretical), std. devn. (i.e. picking error). The next

area shows corresponding information for azimuth and the final one shows slowness information.

This new version of the locator can now use azimuth or slowness information. You select which

type of information will be used for each arrival by selecting the radio button to the left of each

row in each of the data type areas. For our demonstration, select Time for the P phases only. Sort-

ing by phase may make this easier if you have any phases other than P. You can also set the Std.

Devn. values here by typing them in, if you like. The Set Std Dvn buttons at the bottom of each

data type area allow you to do batch replacements, which is handy for data that comes in with null

(e.g. -1.0) Std. Devn. values (this can lead to problems when locating the event). When all is set as
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you like, select Apply to dismiss this popup and return to the MS Locator Tool.

Next we have a series of Control Parameters. First, the origin can either be updated or create a

new one. Second, are radio buttons to control which, if any, of the location parameters (i.e. Lati-

tude, Longitude, Depth and Origin Time) the user wants to fix during the location calculation.

Depth can be further constrained by limiting the depth range of the solution. The Min Depth and

Max Depth are editable for this purpose. The maximum number of iterations can be set based on

the users discretion, default is 100. The next three boxes (Initial Damping Factor (IDF), Damping

Factor Multiplier (DFM), and Damping Distance (DD)) set parameters for applied damping when

non-linear behavior is encountered while determining solution convergence. This algorithm seeks

to keep the damping factor as small as possible by initializing it to zero and by reducing it by

DFM at the conclusion of each iteration. Keeping the damping Factor small keeps the step size as

large as possible. The algorithm is willing to increase the damping factor as much as necessary to

ensure that the weighted RMS residual is never allowed to increase from one iteration to the next.

The DD is another criteria for solution convergence. The idea is, if a solution is calculated and the

differential model change is less than the damping distance then we must be very close to the glo-

bal minimum of the weighted RMS residual, so stop.

When you have the parameters set the way you want, you are now ready to locate the event. To do

this, click on the Locate button. The user should notice two changes. First, the Status line should

have changed indicating the convergence to a solution after # iterations, but there is no guarantee.

If there was a problem (say not enough data), the message given on the Status line may help you

figure out what to do next. Second, the change in the origin and error information sections. The

MS Locator Tool lat and lon should change to reflect the new location. If the solution seems con-

verges to the wrong location, you may be able to “guide” it back by typing in more reasonable lat/

lon values and re-locating.

Two buttons at the bottom of the MS_Locator allow the user to view different solution informa-

tion. The geographic location of the event can be seen using the Open Map Tool button. The

solution iteration information is accessed by clicking on the Plot Solution Data button.

If you want to add an arrival for another station and add it to the calculation of the location, or you

want to retime one of the stations already being used, just go back to Measure Tool, add/retime

the arrival, and then click on the MS Locator Tool button again and the information will be

updated in MS Locator Tool, and proceed as outlined above.
44



Calculating Magnitude

The tutorial data set is not well-suited to calculating magnitude due to the lack of instrument and

sensor tables and corresponding instrument response files which are needed to convert measure-

ments to true ground motion units. We will address this in a future release, but in the meantime we

can still use our demo event to illustrate the basic procedure. Begin by using Measure Tool to
making Zero-Peak P measurements for all 4 stations (just pick the largest peak in the first 5 sec-

onds or so after the first arrival). Next set the Save to Arr. Amp. popup to Zero-Peak. Now click

on the Magnitude Tool button in the Send to Tools area. The Magnitude Tool should popup

presently. (It can also be launched from the Mag pulldown menu). Note that it does not show the

measurements we have just made. This is because by default it comes up using a Surface wave

formula that looks for LR phases. In the Magnitude Calculation area, click on the Wave Type
popup and select Body (instead of Surface). The Algorithm will automatically switch to Richter,
but if you wanted to use a different body wave formula you could click on this popup and choose

another one. Now the measurements for the 4 stations should show up in the list and the thumb-

nail map in the lower center will expand its view enough to show all 4 stations and the event:

You will probably notice that some of the station lines in the list are “grayed out”. This is because

the Arrival Filters as set are excluding them. Compare the ranges of acceptable values for Dis-
tance Range and Period Range with the distance and period values for the measurements to see

why they are grayed out. Try changing the filter ranges to encompass the grayed out values and

see what happens. Note that Phase is also a filter which you can type in by hand and that you can

use a comma separated list if you want to use more than one phase.

We now have individual magnitudes for each of the stations (though quite possibly nonsensical

values due to the “periods” we are using) in the Arrivals window under the Mag field, and the

overall magnitude for the event, as shown in the origin line at the top (mb - body wave magnitude,

ms - surface wave magnitude and ml - local magnitude), in our case just the body wave field

should have a value. The network, or overall magnitude is recalculated as stations are added. To
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add stations to the network calculation, just click on the radio button to the far left of each in the

list. As you do, you will notice that the network magnitude and std. devn. change and also that the

triangle symbol for that station in the map changes from black to yellow, so you can get a crude

idea of the station coverage.

If you want to calculate maximum likelihood magnitude for any of the formulas (and assuming

that you have marked some arrivals as sub-noise and/or clipped), just push the Maximum Likeli-
hood radio button. Note that without sub-noise or clipped arrivals this option will not change the

magnitude calculated.

If you want to make a measurement for another station and add it to the calculation of the magni-

tude, or you want to remeasure one of the stations already being used, just go back to Measure
Tool, make the measurement, and then click on the Magnitude Tool button again and the infor-

mation will be updated in Magnitude Tool.
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Infra Tool

(Note: Several features have not been included in the Web release of Infra Tool, specifically the

signal detection algorithms, and write detection file. Contact Rod Whitaker (rww@lanl.gov) for

obtaining the complete version of the new release of Infra Tool).

Several additions have been made to Infra Tool since the release of MatSeis-1.7. Grid lines can

now be added to each of the window axes. Complimenting the ability to write processing results

to file the user can now read those results back into Infra Tool, with the exception of the waveform

data. Theoretical travel-times are now able to be displayed in the waveform window, and when

multiple theoretical travel-times are available the user can switch between the ones defined. Exist-

ing arrivals are also displayed in the waveform window. The arrival can be adjusted along the

waveform by click-n-holding the mouse button down over the arrival and dragging the arrival to

the desired location within the waveform window. Two automated post processing signal detec-

tion algorithms have been added: Inverse Slope and Hough Transform methods. Five threshold

settings were added under the Detection Parameters pop-up menu to accomplish this task, they are

correlation, slope limit azimuth, number of samples, standard deviation for azimuth and azimuth

data gap. If signals are detected by the algorithms the information defined within them can be

written to a file. A matseis environmental variable was added: MS_INFRA_FILE to allow the

user to specify a directory and file name to write results to from within a config file. Finally, the

pass band filtering parameters and slowness parameters were combined into a single location

within the gui and accessed through a pop-up menu selection.

Now we continue with the tutorial, for this we want switch to a different type of data analysis -

Infrasound. For the infrasound section of the tutorial we will use data from 2 arrays from the

Infrasound global network for the August 25, 2000 bolide over the Pacific off Acapulco. **It

should be noted that this is a reviewed, or built event. Meaning that the origin location was deter-

mined through analysis of arrival time, azimuth and slowness data. Because of this the array data

is plotted at the correct distance (in degrees) from the origin with the waveforms cross the theoret-

ical travel-time curves in the correct location.** This data is also included in, test_data, available

from our website. At this point we are going to reconfigure Matseis to read in information used by

the Infra Tool. We’ll do this by using the config file located in the MATSEIS_HOME/test_data/
infra_tool. Start by selecting the new configuration file config.atminf and click Apply.

Now, within Matseis the infra data should be loaded and the MatSeis Waveform Window should
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look something like this:

In MatSeis, we now see waveforms for two infra sound arrays, DLI01-04sd and 159H 1-4, infra-

sound travel time curves, L, S and T, and the origin (#1). (Try aligning on the different TT curves

and zooming in on the waveforms. Adjust the color, line width or any other feature available from

the pop-up menus). Before Infra Tool is launched, select stations for a single array and set the

processing window. Using what we have learned earlier, select the upper array of waveforms

(DLI01-04sd) and zoom in on the area of the waveforms that crosses the TT curves. Next, a pro-

cessing window has to be defined. To create a processing window type <ctrl-s> and using the

cross-hair, left-click and drag the rubber-band box centered around the portion of the waveform

that crosses the S TT curves (See Appendix A: Sig Pro section for more information on selecting

and adjusting processing window). After this, the MatSeis waveform window should look some-
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thing like this:

With the array data now selected, within Matseis, we can launch the infra tool. The Infra Tool is

launched from the Infra pulldown by selecting the Infra Tool menu item, and should look some-
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thing like this:

Infra Tool is configured with four windows to show graphs of Correlation/F-Statistic, Trace

Velocity (km/s), Azimuth (deg) and one waveform. The x-axis is Time. The Correlation plot win-

dow (topmost) has a pulldown menu in the lower right corner to switch between Correlation and

Fstat (i.e. F statistic). Within the waveform window there are two buttons, MatSeis Update and

Station/Channel pulldown (waveform selection). The Matseis Update button updates Infra Tool

to any changes made within MatSeis (e.g. changes in processing window length, or selected
50



waveforms) and replaces existing data. Try modifying the processing window and update Infra

Tool. The Station/Channel pulldown allows the different waveforms to be selected and viewed in

this window. On the right hand side of each axes a radio button was added to add/remove horizon-

tal grid lines to the respective axis.

Below the waveform window are three parameter windows and the windowed results window

(green title box). The window parameter window is a single layer window, while band pass and

detection parameters are popup menus of two layers. The second layer of controls are accessed

through popup menus. By clicking on either Band Pass Parameters or Detection Parameters a

popup menu choice can be made to select Slowness Parameters and Theoretical Arrivals,
respectively. The Window, Band Pass, Slowness and Detection Parameters windows are edit-

able and should be set prior to the calculation step. The first, Window Parameters (blue title box)

defines how the processing of the waveforms is done, by setting window length and overlap.

Duration is the length in seconds of the processing window and is shown as a light blue box, left-

justified, in the waveform window (try different duration lengths and see how the blue box snaps

to the new window length). Overlap is the percent overlap between the processing windows.

Number of windows is calculated based on the entered values for duration and overlap and is the

number of data points to be plotted above. Next, Band Pass Parameters (gray title box) sets the

upper (High frequency) and lower (Low frequency) cutoff frequencies and filter order (Order)
of a butterworth filter that is applied to the waveforms before correlation processing. The Slow-
ness Parameters (also has gray title box) Max Slowness controls the maximum slowness (and

thereby angle of incidence) which will be plotted. # Slowness Values sets the slowness discretiza-

tion. The Detection Parameters (red title box) control the two new algorithms designed detect

signals based on post processing results from waveform processing. The top four detection

parameters controls are threshold criteria that must be met in order to define a single detection.

The first, Correlation defines the correlation value, as displayed in the Correlation/Fstat axes,

that must be exceeded. The second, Slope in AZ defines the limit with respect the slope of the

lines defined by the azimuth data. (The units of Slope are degrees per duration.) The third, Num-
ber of Samples defines the number of azimuth data to take into consideration when determining

the slope using either detection algorithm. The fourth, Stdv in AZ defines the upper limit of stan-

dard deviation of the azimuth data. The final detection parameter, Az data Gap was added to be

able to connect closely spaced detection windows, and defines the number of samples that fall

between two detection windows that should be bridged, or connected once the waveform process-

ing is completed. The Theoretical Arrival controls which, if any, of the theoretical travel time

curves is displayed in the waveform window. If one is displayed it will be colored red and labeled

by the phase name (e.g. S for the tutorial) and the suffix - _theo.

For the tutorial, enter a duration of 70 seconds with 50% overlap, then press calculate to update

the number of windows box. Let’s change the filter parameters, extend the low frequency to 0.1

Hz and leave the high frequency at 3.0 Hz. Increase the filter Order to 4 and leave the slowness

and detection parameters unchanged. Before we calculate the results, note the two buttons in the

lower left corner of the Infra Tool window: Animate and Calculate. Animate is a sticky button

that allow the user to view the step-by-step calculation for the array. Note that because the data are

being plotted, this will take MUCH longer when turned on. If Animate is not on, the plots will

not be updated until the entire set of calculations are done. Calculate executes the moving win-

dow calculation between the waveforms of the array. Click on the Animate button and then press

the Calculate button. When Infra tool is through with the calculations, Infra tool should look
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something like this:

Once the calculations are made, a green box appears in the Correlation, Trace Velocity and Azi-
muth windows. These green boxes are associated with Windowed Values & S.D. window. The

Windowed Values & S.D. window displays the mean value for the data captured within each

green box for each category. If the criteria are met to define a detection then a detection window is

generated in the Azimuth axes for each of the two methods currently available (i.e. Inverse Slope

and Hough Transform). A bright yellow window is used to define the Inverse Slope method detec-

tion and dark yellow is used to define the Hough Transform method detection. In this case both

methods produced an identical detection.
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The green box can be moved by left-clicking in the middle of the window then dragging it to the

desired location, or edited by left-clicking on either edge then dragging to include the desired

data. Try adjusting the green box and see how the values change. Extend the green box to include

all consecutive data points defined by the detection windows and then click on the Send to Map
button. This launches the Map Tool (See Section 5), which plots the station, origin and great circle

(indicating the arrival direction of the pressure wave at the array). For the tutorial, this is from the

south, or 182 degrees. Use Zoom in and draw a box around North America, your display should

look something like this:

MapTool is convenient for plotting origin, station, and other data types (such as the great circle

above).

Write File creates a file (infra_data.asc) in your Matseis_ Home directory, but if you use the new

matseis environmental variable MS_INFRA_FILE in your config file and specify a valid directory

this directory will appear in the edit box to the right of this button. The Write File format was

modified to make reading easier. We now use the following convention: Human Time (YYYY/

MM/DD HH:MM:SS.SSS), Epoch Time, Correlation, Fstat, Azimuth, Trace Velocity (km/s). We

have added the ability to read an Infra Tool waveform processing file generated using the write file

feature by selecting the Read File button. By selecting the Read File button a directory search is

done to find the desired file to be read in, showing the correlation/fstat, trace velocity and azimuth.

To compliment the new ability to detect and define infrasound signals we have added the Write
Detection File button. If a signal detection is defined the Write Detection File button, once

clicked, will generate a file, located and named as defined in the edit box to the right of this but-

ton, listing each detection by method (Inverse Slope and Hough Transform) and the data defined

by each detection window (we use the same format as described above for Write File). Note,

Infra Tool Write File and Write Detection File updates, and overwrites an existing file, hence the

previous data is lost. So be careful!
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General Purpose Utilities

There are several general purpose utilities which may prove useful in your analysis. We discuss

some of these here. **So reconfigure to the Northridge data set, and continue. **

Alpha List

There are actually two alphanumeric lists, one for origins and another for arrivals that are linked.

You will find the tool under the View pulldown menu. Once the tool is launched, select origin 1

(the only choice for the demo data set) and you should get displays like these:

The basic lists provided a nice means to quickly review the various quantities associated with the

origins and arrivals simultaneously, but the tool allows you to do more than this. If you have an

origin selected, you can click on the Control button next to the Origins list and access a set of

actions to perform on the chosen origin (Select, Edit, Zoom, Delete). Similarly, if you select an

arrival in the Arrivals list, you can access similar actions by clicking on the other Control button.

In some cases, it is easier to work from the main MatSeis display and in some cases from lists,

hence we provide this tool.
54



Free Plot

Free Plot is also found under the View pulldown menu, or can be launched by typing <ctrl-f>.

The purpose of Free Plot is to present waveform data in a manner that is less restrictive than the

main MatSeis Waveform Window. As an example, select only the three closest waveforms (i.e.

PAS, NNA and KIV) in the matseis window and launch Free Plot. You should get a display that

looks like this:

Notice that the units for the waveforms are displayed in Free Plot. The default scaling is auto but

you can change to fixed by choosing the corresponding button. You can also turn on zooming with

the Zoom button, simply click and the button will remain depressed (in zoom mode) until clicked

a second time. Left click to draw a box to zoom and right click to unzoom. The Scale buttons,

Auto and Fixed, control whether or not the waveform is automatically scaled whenever you shift/

zoom. Auto scales by each individual waveforms peak amplitude and Fixed scales all waveforms

by the global maximum peak amplitude. Free Plot also has a nice feature for comparing wave-

forms. With Zoom Off selected (it has to be or you will accidentally zoom in the next step), you

can click and hold on any of the waveforms and move it horizontally or vertically anywhere in the

display. Try this to compare waveforms. Note that this is most effective if you have set the wave-

forms to different colors in the MatSeis Waveform Window because Free Plot will use the same

colors as in MatSeis.

Free Plot comes in very handy for looking at waveforms which have been plotted on top of each
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other in the matseis display, something which happens any time you have an origin selected and

you have more than one waveform (e.g. multiple channels) for the same station. Just select all the

stacked waveforms using <ctrl-w> and send them to Free Plot (<ctrl-f>). Note also that you can

select waveforms from within Free Plot using <ctrl-w> the same way as in the MatSeis Wave-
form Window and that you can then delete them using <ctrl-e>, also as in MatSeis. Note that the

selections or deletions will apply to MatSeis as well as Free Plot! Thus, this provides a handy

way of selecting just one of a set of stacked waveforms in MatSeis (e.g. for Signal Processing),

but it could also lead to accidental deletion of waveforms in MatSeis if you are not careful.

To assist in the analysis of waveforms, a filtering tool has been added to Free Plot. Within the Sig
Pro pulldown menu there are three choices: Select Using Mouse, or <ctrl-w>, Filter, and Unfil-
ter. Select Using Mouse will activate the cross hair in Free Plot, select waveform to filter. Filter
opens the Filter Tool popup window (same options as described in Measure Tool - Filter).

Waveforms are simply replaced after the filtering procedure. Unfilter will return display to origi-

nal waveforms. For more on filtering see Appendix B, under SigPro.

Waveforms can be selected in MatSeis using <ctrl-w>, in either aligned or unaligned mode. When

a processing window is defined using <ctrl-s>, only the waveform sections within the processing

window are sent to Free Plot, using <ctrl-f>.

Arrivals can be send to Free Plot as well. To do this, use <ctrl-a> to select arrivals for the three

stations from within the MatSeis Waveform Window. Once the arrivals are selected, will turn

from dull red to bright red. You must also have the three waveforms selected, type <ctrl-f> to send
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to Free Plot. Your Free Plot window should look something like this:

With arrivals now loaded in Free Plot, we can align on the different phases. Under, View->Align-
>Pick Align... Select the phase you would like to align on, select S. Try the P phase. Try the other

options under View to enhance your waveforms viewing experience.
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Signal Processing

A variety of common signal processing tasks can be accomplished using the SigPro pulldown.

Waveform Selection

To perform almost all of the functions, you must first select the waveforms which are to be oper-

ated on. Using one of the methods already learned for selecting waveforms, select all three of the

waveforms shown for the Northridge event.

Output: Create New Waveforms or Replace Existing Waveforms?

Depending on the situation you may want to simply replace the original waveforms with the pro-

cessed waveforms (e.g. for demeaning) or you may want to create new ones (e.g. for comparing

the effects of different filters). Either option is available through the Options item of the SigPro
pulldown. For the tutorial choose Create New Waveforms (this should be the default setting), as

we do not want to lose the original waveforms.

Setting the Time Interval for Processing

The processing can be applied to the entire selected waveform or to some specified interval via the

Time Segment menu of the SigPro pulldown. the default is Off which means the whole wave-

form will be processed. There are several different methods you can choose for setting a time seg-

ment for processing. Setup pops-up a window which allows you to type in the time limits, but we

seldom use this method. Pick Using Mouse, the most useful option, allows the user to set the seg-

ment lines using the mouse to drag a box, and this option can also be invoked directly from the

matseis Waveform Window by typing <ctrl-s>. Try this.
58



The display should look like that shown above. The grey dashed lines indicate the time window

for analysis. Once these are visible you can adjust them by left clicking, holding down the button,

and grabbing either the left or right and moving it. Release the button to fix the new position. Note

that you can also slide the whole segment window by “grabbing” the horizontal dashed line at the

bottom of the screen in a similar manner.

A final means to set the segment lines is using Set to Axes, which will set them to the limits of the

Waveform Window. Regardless of which method you use, selecting Off reverts to the default

behavior (time segmenting turned off) and this can also be done using <ctrl-q>.

For the tutorial, we have only a small section of waveforms read in so we will select Time Seg-
ment->Off. For longer waveforms, however, we highly recommend windowing the section of

interest using <ctrl-s> to avoid unnecessary processing.

Signal Processing/Analysis Applications

At this point you are ready to process the selected waveforms. You can select from among the

many options in the SigPro pulldown (Appendix A). The best way to learn about these functions

is simply to try them on data. The function of most them should be clear to anyone with some

experience in seismic data analysis. Many do nothing more than call a basic MATLAB function.

To help in getting started, we provide a few examples on the following pages.

Example 1: Filtering

As an example of one of the more commonly used functions, choose Filter Design from Filters.

A pop-up will appear which allows the user to design a custom filter and apply it to the selected

waveforms.

This function is an excellent illustration of the power that MatSeis has due to the underlying

MATLAB code. The only code developed for this function was that necessary to set up the popup

GUI; all of the filtering is standard MATLAB (plus the MATLAB Signal Processing Toolbox).

For the tutorial select all of the waveforms (if they are not already), and design and apply a But-
terworth, Band Pass, 0.8 - 2.0 Hz, Order 3, Zero Phase filter. You should now have six wave-

forms displayed, but this may not be evident because the filtered waveforms will be plotted on top
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of the raw waveforms (they have the same epicentral distances). Note, however, that the station/

channel identifiers of the new waveforms end in “bp” for band-pass.

Separating Super-imposed Waveforms

There are many ways to “separate” the waveforms, start by unselecting the waveforms (<ctrl-n>).

First, you can make them different colors so that differences can be seen where they are not simi-

lar. The simplest way to do this is to use the Color option of the Wfm pulldown and select ran-
dom. Try this. Another method is to offset one of the waveforms when they are superimposed.

Left-click on one of the NNA waveforms (or station/channel identifiers) to bring up the Station-
Channel/Waveform Functions Pop-up, as discussed previously, and select Edit to bring up the

Waveform Properties Window. One of the properties is Offset. This is a vertical offset in

degrees. Try changing it to 5 and Apply. The superimposed waveforms will now be separated:

This method has provided the desired result and we would encourage the user to employ it where

appropriate, but we generally avoid it because it has the disadvantage of having changed the dis-

tance at which the offset waveform is plotted to something that is no longer valid. This can lead to

confusion subsequently if one decides, for example, to delete the raw waveform and work with

the filtered version and forgets about the offset.

In some cases a better method is to take advantage of the mode of waveform display mode used

by MatSeis when no origin is selected. Before we illustrate this, however, we need to get rid of the

offset we added or it will adversely affect things. We could just add a negative offset to move the

waveform back, but to be extra safe (and to make the reader practice a little more) instead you

waveforms separated

by offset

superimposed waveforms
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should delete all of the filtered waveforms using the Delete option of the Waveform pulldown

(this will bring up a list of choices: select all stations, but only the BHZbp channel), and then rec-

reate the filtered channels by using Filter Design again (all of the stations should still be

selected). Note that the filter parameters do not have to be reset; the last values are retained. When

you are done with this you should once again have 3 sets of 2 superimposed waveforms. Set the

waveform colors to random to verify this.

Now we are ready to separate again. Begin by unselecting the origin (use any of the methods

described previously). The travel time curves disappear because there is no origin to reference to,

and the waveform sorting order for display is different because epicentral distance is not defined.

The viewing reference frame is no longer well-suited to the data, so zooming is required. This can

be done with the methods we used previously, or we can use the data zoom button (Zoom But-
tons area), which automatically zooms to a window just big enough to show all of the data. Try

this button. The display should now look something like this:

The grouping is first by type of processing (raw, filtered) and then alphabetically by station name

within those groups. This type of display is particularly effective when comparing processing

results for a suite of algorithms (e.g. a range of filter bands).

To get back to the origin-tied display mode, use the undo zoom button and then select the origin

(you can use the Select option of the Orig pulldown if the origin is not visible). We have found

this method of working back and forth between the display modes to be very useful in some situa-

tions. Please make sure that you have the origin selected again before proceeding. You can again
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use the data zoom button to automatically zoom to a nicely framed window once the origin has

been selected.

A final way to separate overlain waveforms is to use Free Plot, as described previously. In this

case, just select whichever group of waveforms you wish to separate using <ctrl-w> (you could

select all three bunches in this case, or any of the individual bunches) and launch Free Plot using

the View pulldown or <ctrl-f>. Try this.

Example 2: Spectrograms

The second example shows how to make spectrograms from selected waveforms. If the wave-

forms of interest are already selected (select the three raw waveforms, the three filtered wave-

forms, or all the waveforms if you like), and you have chosen the analysis windowing you want

(in this case, the whole waveforms) all that is needed is to select the Spectrogram option of the

SigPro pulldown. A pop-up will prompt you for Low Frequency, Window Overlap, and Win-
dow Type. Make your selections, we suggest to change the window overlap to 80, and select

Apply. A window will appear with the spectrograms.

Use the View pulldown on this window to add a colorbar, change the colormap, or zoom. We

have added to ability to animate the spectrogram. First Enable the animation capability, then

press Auto Play. The waveform segment seen in MatSeis will moved along by the value set in the

Step edit box and spectrograms are calculated for the segmented waveforms and displayed in the

Spectrogram Window. Try this out!
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Example 3: Three-Component Analysis

MatSeis includes several tools to aid in the analysis of three-component data. To illustrate we will

need to add horizontal component data. Go ahead and delete the filtered waveforms from the pre-

vious section to keep the display from getting too cluttered. Use the full zoom button to set the

window properly, then use the Waveform Read popup to read in the BHN and BHE channels

for the stations previously read in. Be careful NOT to read in the BHZ channels again; if you do

you will have multiple copies and this may lead to confusion. Make sure to choose the Add option

in the Waveform Read popup rather than Replace or you will lose the BHZ channels already

read. Once the horizontal channel data is read in, select the undo zoom button to get back to the

zoomed view we had been working with.

Data Rotation

First, we will rotate the data. Select all three of the NNA channels using <ctrl-w> and the drag

box. Next set a processing window around the P arrival using <ctrl-s> and the drag box. Your dis-

play should look something like this:

Now choose the Three Component->Rotate option on the SigPro pulldown. A popup will
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appear offering you various choices:

Type of Rotation allows you to choose to do a full rotation (i.e. include the vertical) or only

rotate the horizontal components within the horizontal plane. Note that several of the options are

only valid for the full rotation option and so will be grayed out for horizontal rotation. You can

type in the directional information for the rotation by hand or point to the selected origin by

choosing Set to Origin. For the tutorial, we will choose Horizontal (2C) and select Set to Origin
to rotate to the current origin. Choose Apply when the proper selections have been made.

The rotated waveforms will now be available but they will be plotted at the same distance as the

others and so will be difficult to see. To easily view them, we will use Free Plot. Select all of the

NNA waveforms using <ctrl-w> and type <ctrl-f> to launch Free Plot.
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Polarization Analysis

Next we show a tool to quickly asses the polarization information. To keep things from getting too

confusing, let’s delete the rotate waveforms from within Free Plot. To do this, use <ctrl-w>

within Free Plot to select them (i.e. the three ending in trn, rad, and vrt) -- note that they become

selected in both Free Plot and the matseis Waveform Window, and use <ctrl-e> within the Mat-

Seis Waveform Window to delete them. The waveforms are now deleted from MatSeis though

they still appear in the Free Plot display. Dismiss/exit Free Plot.

Now we can proceed with the polarization analysis. Once again select the three raw channels for

NNA, and using <ctrl-s> segment a small window (~10 seconds) centered around the P arrival.

Note that the leading edge of the travel time curve is the true value for the IASP91 tables. Zoom in

if you like to make it easier to set the window. Choose the Three Component ->FK3C option on

the SigPro pulldown. We call this “FK3C” because the output looks like an FK (frequency-wave

number) diagram for an array, but the processing is completely different: we show the power

polarized in each direction as a ratio of the total power. If you have selected the sub-option cor-

rectly, a popup should appear:

Max Slowness controls the maximum slowness (and thereby angle of incidence) which will be

plotted. # Slowness Values sets the slowness discretization. Local Velocity is used to convert

slowness values to angles of incidence. Hilbert Transform Horizontal Components is useful

for LR waves to equalize the phase difference between vertical and horizontal so that the power

will appear to be linearly polarized. Enhance Peaks makes the peaks more evident in the plot. For

the tutorial, we’ll just use the default values, and select Apply.
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As suggested above, this display should be interpreted just like an FK. The horizontal and vertical

axes show the EW and NS wave numbers respectively. The thin white circles show the theoretical

P slownesses for 5, 20, and 100 degrees distance for an event depth equal to the depth of the cur-

rently selected origin. The small white circles and accompanying labels the travel time curves cur-

rently in MatSeis (in this case P, S, and Lg) show the theoretical slowness and azimuth positions

for these phases for the station being analyzed, in this case NNA. The center of the bull’s-eye,

marked with an “X” shows the direction of greatest polarization, which in this case should be near

the P marker.

We have added the ability to set an arrivals azimuth and slowness based on this analysis by select-

ing the respective button: Set Azimuth and Set Slowness. The values which will be used are

given in the title of the plot shown in this window. The available arrivals for the selected wave-

form are listed in the listbox and the one falling within the waveform segment set in MatSeis is the

one shown as selected. In this case, the selected phase will be P.

There is a control box in the upper right which allows the user to animate this display. To do this,

select the Enable button. The FK-type plot will now be automatically updated whenever the seg-

ment window (indicated with the gray dashed lines) is changed. Try dragging the window along

(you can grab the bottom, horizontal part of it by left clicking the mouse to do this) and watch

how the display changes. If you have a slow computer, this could be painful. For better perfor-

mance, and more precision, make the analysis window shorter. You can also automatically play

through an arrival using the Auto Play button. To do this, first position the segment window well

in front of the phase. Next type in the step value (this is in seconds). Try 5. Next select the Auto
Play button (note that Enable must also be selected). You should now see the analysis window

march along step by step and the display window update as it does. You can stop the calculation

by pushing the Auto Play button again (it should now be unpressed). You must also deselect the

Enable button to stop the automatic calculation before you leave this tool, otherwise MATLAB

will accept no further commands from MatSeis!!!

Example 4: Array Analysis

MatSeis includes several tools to aid in the analysis of array data. Because of this we supply array

data for the India nuclear test on May 11, 1998 for the ARCESS array in Norway and the Alice

Springs array in Australia. Though we supply several array processing tools, we’ll begin by cover-

ing the following three: general and event beamforming, f-k analysis and arrival transfer.

We first need to reconfigure using the array configuration file. Start by selecting Reconfigure
from the File menu. After the reconfigure window comes up, select Config File... . This will open

a directory search window. Navigate up to the MATSEIS_HOME/test_data/matseis/array direc-

tory and open it. Select the configuration file labeled: india-array.config. Set both Reset Default
Configuration and Delete Existing Data radiobuttons “on”. The reconfigure window should
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look something like the following:

When you are ready, click Apply. MatSeis will automatically load the origin and waveforms. You

should now have waveforms for the two array’s and an origin loaded into MatSeis. To reduce pro-

cessing time during this part of the tutorial, delete the waveforms for the Alice Springs array

(AS01-AS19). Use your preferred method of deleting waveforms. Next, make sure you are not

aligned on a travel time curve and zoom in on the data centered around the P travel time and set a

waveform segment, after doing so your MatSeis display window should look something like the

following:

Beamforming

With an array the coherent signal can be enhanced through a process of summing the signals from

the seismic array sites. The process of summing the seismic waveforms is commonly called “slant

stack” or “delay and sum”. The idea is to find the best delay time to shift each waveform before
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summation so as to get the largest amplitudes due to constructive interference of the signal and

destructive interference of noise.

There are two common ways of using beamforming: estimation of slowness and station to event

azimuth when event location is unknown and when the event location is known. The first uses a

range of azimuth and slowness values and computes several beams. For each of the beams the sig-

nal power is calculated. The azimuth and slowness of the beam with the maximum power, corre-

spond to the back-azimuth of the array to event and the slowness of the windowed phase,

respectively. This is the default behavior for General Beam tool. The second method is to use an

events location to compute the beam, basically we define the beam azimuth and slowness relative

to the origin. Use the Set to Origin button to set the this method when using General beam Tool.
When using the set to origin option, the number of slowness values shown in the edit box are

related to the number of travel-time curves currently loaded in MatSeis. This same task can be

done using a new tool called Event Beam tool. In Event Beam tool the azimuth is set to the sta-

tion to event azimuth, while the phase is set to the travel-time phase falling within the set wave-

form segment window in MatSeis and sets the slowness value to use.

Let’s start by determining the backazimuth (direction) and slowness (distance) of the event the

array. First, select all the ARCES array waveforms (try <ctrl-w> to select waveforms). Now

choose the Array -> General Beam option on the SigPro pulldown. A popup will appear offer-

ing you various choices:

In the General Beam Tool window several parameters can be set. Azimuth can be either a scalar

of vector value and refers to the azimuthal direction about the array to use when computing the

signal power. Slowness can be either a scalar or vector and refers to the apparent velocity, or slow-

ness to use when computing the signal power. The N-th Root process is a non-linear method to

enhance the signal-to-noise ratio (SNR) during beamforming. Before the signals are summed the

N-th root of each trace is calculated, the sign information is retained. And after the summation the

beam is raised to the N-th power. In the n-th root process more weight is placed on the signal

coherence than on the amplitude, which results in a distortion of the waveforms. The larger N, the

less the original waveform of the signal is preserved. However, the destructive interference of

noise is better than with linear beamforming. So if you feel up to it go back and try beamforming
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using different roots. Next are the output modes, which are discussed below. Finally, Station
Name (common array reference station is used as default) and Channel Name for the new beam

site waveform are set.

Start by selecting the Beam Set Power (Image) button. By selecting the Beam Set Power button,

the computed beam power is plotted for the specified range of azimuth and slowness values.

Leave the rest of the setting to their default values and click Apply. The following figure window

will come up:

The Beam Set Power window displays the individual beam signals power, plotted by azimuth

(angular degrees) and slowness (radial distance). A title was added to include the Slowness and

Azimuth of the maximum beam power, which are: Slowness = 8 (sec/deg), Azimuth = 142.5 deg

for this example. Under View, you can display and modify the colormap or shading of the plot

window. Interpreting this plot is simple. You simply look for the region of hot colors (unique for

this colormap) indicating the azimuth and slowness values which yield the largest power values.

So we can see that arriving waves approached the array from an azimuth of 120 to 170 deg and the

slowness of this phase is between 4 and 8 sec/deg. Try refining slowness vector in the 4-8 range to

see if you can better resolve the slowness of the window phase, P in our case. Try for example the

slowness vector: “[4 5 6 7 8]” and recompute the Beam Set Power.

Now we can compute and plot the array beam for a known origin using the new Event Beam
Tool. Again select Array -> Event Beam option on the SigPro pulldown. The tool automatically

sets the station to event azimuth. The slowness is determined by the TT curve falling within the

waveform segment window, in this case P. Lastly, change the Station Name, or Channel Name to
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a descriptive naming convention. Before clicking apply, the window should something like this:

Now click Apply, and the beam is computed and drawn in MatSeis. Try selecting the new beam

waveform and sending it to freeplot (beam waveform fifth from the bottom). Also, try viewing all

the waveforms together and see if there was a recognizable enhancement of the signal’s SNR.

F-K

Frequency wavenumber analysis, F-K analysis, is used as an estimator of slowness. In principal,

we beamform in the frequency domain for a number of different slowness values. For example, if

61 slowness values were used, then a 61 x 61 grid of power values are obtained. The resulting plot

shows power, color coded for magnitude, of the signal for the points in slowness space. Since our

analysis is in the frequency domain we must supply a specific frequency range to analyze. The
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default frequency range of 2-5 Hz is used for FK Tool and Fast FK Tool. The difference in these

tools as the names imply is speed. From FK Tool one can set the determined azimuth and slow-

ness to an existing arrival, similar to 3-C FK, while Fast FK Tool has the ability to animate the

slowness space as the waveform segment window steps along in MatSeis.

For the tutorial, continue to use the ARCES array data. Start by selecting the ARCES station

waveforms and add an P arrival within the waveform segment window, then select the Array ->

FK option on the SigPro pulldown menu. This will launch the FK Tool window, shown below.

From this window you can set several processing options. Starting with the Max Slowness, this

sets the dimension limits in slowness space. Next is the # Slowness Values, this sets the resolution

of the resulting grid plot. The Frequency Band defines the frequency content used in the analy-

sis. Click on Window Type and a popup menu lists several commonly used pre-filter windows to

select from. Enhance Peaks is a radiobutton (has two positions ‘on’ and ‘off’) when on the image

is rescaled to “enhance” the location of the peaks power. Interpolate Image is also a radiobutton,

and when turned ‘on’ the resulting image is interpolated, reducing the graininess of the image.

Use the default values, and click Apply. After calculating the beams, the power values are plotted

for the different combination of slowness values. The plot should look something like this:
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The location of the maximum power in slowness space gives the slowness (7.77 sec/deg) and

using basic trigonometry the azimuth is obtained (121.0 deg). Since an arrival fell within the

waveform segment window it appears in the listbox and the azimuth and slowness can be set using

the Set Azimuth and Set Slowness buttons. Now try changing the setting, and use the other plot-

ting options to see the effects of your changes on the computed azimuth and slowness of the

observed maximum in the FK image. Also, try using Fast FK Tool and its animation capability.

Arrival Transfer

Arrival transfer was created for moving phase time arrivals between different elements of an

array. One might use Beam Tool to form the beam waveform, then pick the arrival time of that

beamed phase. The analyst may want the new arrival associated to another station. Simply use

arrival transfer to move the arrival.

For the tutorial we’ll demonstrate the concept of arrival transfer. Start by zooming in on the P-

phase travel-time curve. Next, we’ll have to add an arrival. With the mouse pointer over the wave-

form for array site ARD4, right click. The waveform popup menu will come up, select Add
Arrival from the list. This will add an arrival at the location the mouse pointer was clicked, with

the default phase name UNK, for unknown. Now we’ll need to change the arrival name. Right

click on the arrival, and the arrival popup menu will come up. Highlight and edit the Phase field

to P and hit return, which should close the popup menu. The width of the P travel-time curve was

also changed to 0.1 sec. The MatSeis window should now look something like this:
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Now, select the Array -> Arrival Transfer option on the SigPro pulldown menu, and the follow-

ing Arrival Transfer Window will open, but initially will look different:

Now select the arrival you want to transfer, in our case the P phase we just added. Once the arrival

has been selected the Waveform(s) for Transfer listbox and Channel listbox are updated based

on the selected arrivals associated reference station and channel. The refsta and channel edit boxes

are supplied to limit the displayed waveforms and channels to those set in the appropriate areas.

You can use <ctrl-a> to draw a rubber band box around the arrival to select it. We can see that the

P arrival is associated to station ARD4 with channel SHZ. So select another station (e.g. ARD7)

from the ones provided in the Waveform(s) for Transfer list and channel SHZ from the Channel
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list. Click Apply, and automatically the arrival is transferred to the selected waveform, see below:

The Arrival Transfer Tool window will stay open until the Cancel button is selected. Try trans-

ferring the arrival to other waveforms. That’s all there is to arrival transfer.

Arrival Travel Time

One final tool to look at is the Arrival Travel Time tool. This new tool was designed to plot the rel-

ative arrival times versus epicentral distance (station to event) for a group of events occurring

from a common region. To see how this tool works we will meed to Reconfigure to the Galilee

data set, supplied in the test_data directory. Reconfigure using the galilee.config file. Then select

the Zoom Origins button to view all the loaded origins. Arrival have only been loaded for the first

origin, so go ahead and load arrivals for the rest of the origins. (Make sure not to have duplicate

arrivals read in for any of the origins). Once this is done select Arrival Travel Time from the Arr
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pulldown menu. This will open the Travel Time by Arrival window, seen below.

The Number of Origins in MatSeis should be 9 and the Number of Arrivals in MatSeis should

be 270. In the Phase(s) to Plot edit box add Pg, then click Apply. The relative arrival times are

then plotted along with the theoretical travel time curve(s) for the listed phase(s), Pg for the tuto-

rial. By clicking the mouse while the cursor is located over the travel time curve the phase name is

displayed. If this is done while over a data point then the average travel time in KM/sec is dis-

played. Try zooming in an epicentral distance of 0 to 3 (deg) and a relative arrival Time of 60

(sec). (This can be done by selecting Zoom In from the Tools pulldown menu.Remember to turn
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zooming off after you are finished). The window should now look something like this:

We can see that most of the arrivals times fit their theoretical values, for this phase. Try other

phases and the Shift Origin to Depth feature, which will calculate the arrival times relative to the

Shift Origin to Depth value instead of the true origin depth. (When multiple phase are given each

phase is given a unique color from a preset list.) Also try to rotate the axes to view the origins ver-

sus depth (Rotate 3D can be accessed by the Tools pulldown menu).

This completes the tutorial. We encourage users to fully explore all functions available through

pulldowns using Appendix A, which gives brief description of each function. In most cases, the

user should be able to figure out how to use these tools on his/her own.
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MatSeis Section 5:
Map Tool

Map Tool is a map display utility used in conjunction with MatSeis. It was designed as an aid to

MatSeis by providing an easy to use graphical interface for locating origins and stations. It pro-

vides point-and-click zoom control of the map display and fourteen azimuthal, cylindrical, and

conic map projections. In addition, Map Tool supplies data management capabilities which allow

the user to read in data from other sources.

Map Tool’s Creators

Map Tool was created by John Merchant. It makes use of a map projection package called m_map

(http://www2.ocgy.ubc.ca/~rich/map.html) written by Rich Pawlowicz.

Starting Map Tool

To start Map Tool, select the Map Tool option from the View pulldown menu.
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Environment Variables

Map Tool has many environment variables that can be set in the MatSeis configuration file. This

file is typically read upon start-up or whenever MatSeis is reconfigured. Also, these environment

variables can be set in a mapfile data file (see the Mapfile Format section).

MS_MAP_WATER_COLOR Water color. R,G,B color spec.

MS_MAP_COAST_COLOR Coastline color. R,G,B color spec.

MS_MAP_LAND_COLOR Land color. R,G,B color spec.

MS_MAP_COAST_WIDTH Coastline width in points.

MS_MAP_GRIDLINES Visibility of gridlines. (‘on’ or ‘off’)

MS_MAP_LOCATION Visibility of location. (‘on’ or ‘off’)

MS_MAP_COAST Visibility of coastline. (‘on’ or ‘off’)

MS_MAP_AXES_LIMIT Viewable axes range. min_lat, max_lat, min_lon,

max_lon.

MS_MAP_AXES_LIMIT_MAX Maximum axes range. min_lat, max_lat,

min_lon, max_lon

MS_MAP_PROJECTION Map projection to display.

MS_MAP_STA_MARKER Station marker.

MS_MAP_STA_COLOR Station color. R,G,B color spec.

MS_MAP_STA_SIZE Station marker size.

MS_MAP_STA_FONTSIZE Station fontsize.

MS_MAP_STA_SEL_COLOR Selected station color. R,G,B color spec.

MS_MAP_STA_SEL_SIZE Selected station marker size.

MS_MAP_STA_SEL_FONTSIZE Selected station fontsize.

MS_MAP_ORG_MARKER Origin marker.

MS_MAP_ORG_COLOR Origin color. R,G,B color spec.

MS_MAP_ORG_SIZE Origin marker size.

MS_MAP_ORG_FONTSIZE Origin fontsize.

MS_MAP_ORG_SEL_COLOR Selected origin color. R,G,B color spec.

MS_MAP_ORG_SEL_SIZE Selected origin marker size.

MS_MAP_ORG_SEL_FONTSIZE Selected origin fontsize.

MS_MAP_DATA_MARKER Data marker.

MS_MAP_DATA_COLOR Data color. R,G,B color spec.

MS_MAP_DATA_SIZE Data marker size.

MS_MAP_DATA_FONTSIZE Data fontsize.

MS_MAP_DATA_DIR Directory for data files.

MS_MAP_DATA_FILE Mapfile read in on start-up of Map Tool.

MS_MAP_GSHHS_DIR Directory for gshhs files

MS_MAP_TITLE Title displayed above the map

MS_MAP_ZOOMBUTTONS Visibility of zoom buttons. (‘on’ or ‘off’)

MS_MAP_DATABUTTONS Visibility of data buttons. (‘on’ or ‘off’)

MS_MAP_BORDER Visibility of border. (‘on’, ‘off’, or ‘fancy’)

MS_MAP_GCTHEO Visibility of theoretical great circle paths.
(‘on’ or ‘off’)

MS_MAP_GCOBS Visibility of observed great circle paths. (‘on’
or ‘off’)
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Data

Map Tool provides the ability to read and display data. Data can be read directly from MatSeis or

from data files that adhere to the mapfile data format. Origins and Stations are read from MatSeis

automatically on startup or whenever the Update control button is clicked. For additional details

on the mapfile data format see the Mapfile Format section. Map Tool can recognize the following

data types:

Type Description

Point A marker drawn at a lat/lon location with a label.

Scaled A point with no label whose size is scaled to some value.

Origin A point representing an origin.

Station A point representing a station.

Line A series of connected lat/lon locations.

Ellipse An ellipse drawn at a lat/lon location.

Patch A series of connected lat/lon locations with a face color.

Surface Gridded elevation data.

Trisurf Point defined elevation data

All data objects in Map Tool are assigned a group name. These group names can then be listed on

the right side of the Map Tool window. Multiple data objects can be given a common group name

and thus be controlled as a whole.

Data Properties

Each data type has properties that can be set to control appearance and behavior.

Point

Property Description

Group Name of the group.

Location Latitude, Longitude.

Label Label String.

Font Size Size of Label in points.

Label Color R,G,B color spec.

Label Visible Visibility of the label. (‘on’ or ‘off’)

Marker Marker Style.

Marker Size Size of Marker in points.

Edge Color R,G,B color spec.

Face Color R,G,B color spec.

Visible Visibility of the object. (‘on’ or ‘off’)

Scaled

Property Description
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Group Name of the group.

Location Latitude, Longitude.

Marker Marker Style.

Marker Size Size of Marker in points.

Edge Color R,G,B color spec.

Face Color R,G,B color spec.

Visible Visibility of the object. (‘on’ or ‘off’)

Origin

Property Description

Group Name of the group.

Location Latitude, Longitude.

Label Label String.

Font Size Size of Label in points.

Label Color R,G,B color spec.

Label Visible Visibility of the label. (‘on’ or ‘off’)

Marker Marker Style.

Marker Size Size of Marker in points.

Edge Color R,G,B color spec.

Face Color R,G,B color spec.

Visible Visibility of the object. (‘on’ or ‘off’)

Station

Property Description

Group Name of the group.

Location Latitude, Longitude.

Label Label String.

Font Size Size of Label in points.

Label Color R,G,B color spec.

Label Visible Visibility of the label. (‘on’ or ‘off’)

Marker Marker Style.

Marker Size Size of Marker in points.

Edge Color R,G,B color spec.

Face Color R,G,B color spec.

Visible Visibility of the object. (‘on’ or ‘off’)

Line

Property Description

Group Name of the group.

Location Nx2 vector of Latitudes and Longitudes defining the vertices.

Line Style Style of the line.

Line Width width of the line.

Line Color R,G,B color spec.
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Visible Visibility of object. (‘on’ or ‘off’)

Ellipse

Property Description

Group Name of the group.

Location Latitude, Longitude, Major, Minor, Strike.

Line Style Style of the line.

Line Width Width of the line.

Line Color R,G,B color spec.

Visible Visibility of object. (‘on’ or ‘off’)

Patches

Property Description

Group Name of the group.

Location Nx2 vector of Latitudes and Longitudes defining the vertices.

Edge Color R,G,B color spec.

Face Color R,G,B color spec.

Visible Visibility of object. (‘on’ or ‘off’)

Surface

Property Description

Group Name of the group.

Location [ Min_Latitude Max_Latitude Min_Longitude Max_Longitude ]

Shading How surface is drawn. (‘flat’,’texturemap’,‘interpolate’, or ‘con-

tour’)

Visible Visibility of object. (‘on’ or ‘off’)

Trisurf

Property Description

Group Name of the group.

Location Nx3 vector of Latitudes, Longitudes, and color indices

Linestyle Style of the line.

Linewidth Width of the line.

Linecolor R,G,B color spec.

Marker Style of the marker.

Markersize Size of the marker in points

Edgecolor R,G,B colorspec.

Eacecolor R,G,B colorspec.

Shading How surface is drawn. (‘flat’,’texturemap’,‘interpolate’, or ‘con-

tour’)

Visible Visibility of object. (‘on’ or ‘off’)
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Mapfile Format

Data can be read into Map Tool from files that adhere to its mapfile format. A mapfile can contain

any number of data objects. A data object is declared in a mapfile by typing the name of the object

and then any property/value pairs. The properties and values must be on the same line as the type

declaration. However, the line can be of any length. The properties all have default values. So,

defining the property values is optional. Properties and values are enclosed by single quotes and

separated by commas. Two single quotes directly beside each other represents a single quote

inside of the property/value quotes. Anything after a # is considered to be a comment. Conse-

quently, the # symbol cannot be used except as a comment. On the lines directly following the

header is the location data for the object. For an example mapfile, see template/mapfile.

Note: Many of the data objects contain a handlemode property. This property can be set to either

‘multiple’ or ‘single’. This property controls how object handles in Matlab are assigned to the

data being read in. Specifically, if the handlemode is set to ‘multiple’, then each data point

declared within a block is assigned its own object handle. If the handlemode is ‘single’, then a sin-

gle object handle is used for all of the data within the block. For a large number of data points,

handlemode ‘single’ is much faster. However, labels cannot be displayed and will be ignored.

Type

point

scaled

station

line

ellipse

origin

patch

surface

trisurf

file

env

Point

Property Description

group Name of the group.

fontsize Size of Label in points.

labelcolor R,G,B color spec.

marker Marker Style. (See Marker Styles)

markersize Size of Marker in points.

edgecolor R,G,B color spec.

facecolor R,G,B color spec.

visible Visibility of object. (‘on’ or ‘off’)

labelvisible Visibility of label. (‘on’ or ‘off’)

handlemode (‘multiple’ or ‘single’)
82



Location Data

A group of points with the same properties can be defined in the same block. Each line of

data defines a point. The label is optional.

point ‘group’, ’point’, ’fontsize’, ’12’, ’labelcolor’, ’1 0 0’, ’marker’, ’point’, ’mark-
ersize’, ’12’, ’edgecolor’, ’1 0 0’, ’facecolor’, ’1 0 0’, ’visible’, ’on’, ’labelvisible’,
’on’,’handlemode’,’multiple’
Latitude Longitude Label
...

Scaled

Property Description

group Name of the group.

marker Marker Style. (See Marker Styles)

edgecolor R,G,B color spec.

facecolor R,G,B color spec.

visible Visibility of object. (‘on’ or ‘off’)

min Minimum marker size.

max Maximum marker size.

Location Data

A group of scaled points with the same properties can be defined in the same block. Each

line of data defines a scaled point. The marker size is scaled linearly for each marker

between ’min’ and ’max’ for the entire block.

scaled ‘group’, ‘scaled’, ’marker’, ’point’, ’edgecolor’, ’1 0 0’, ’facecolor’, ’1 0 0’,
’visible’, ’on’, ‘min’, ‘1’, ‘max’, ‘12’
Latitude Longitude Value
...

Station

Property Description

group Name of the group.

fontsize Size of label in points

labelcolor R,G,B color spec

marker Marker Style. (See Marker Styles)

markersize Size of marker in points

edgecolor R,G,B color spec.

facecolor R,G,B color spec.

visible Visibility of object. (‘on’ or ‘off’)

labelvisible Visibility of label. (‘on’ or ‘off’)

handlemode (‘multiple’ or ‘single’)

Location Data
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A group of points with the same properties can be defined in the same block. Each line of

data defines a point. The label is optional. A point and a station have the properties, the sta-

tion type just serves to explicitly define this data as a station.

station ‘group’, ’station’, ’fontsize’, ’12’, ’labelcolor’, ’1 0 0’, ’marker’, ’point’,
’markersize’, ’12’, ’edgecolor’, ’1 0 0’, ’facecolor’, ’1 0 0’, ’visible’, ’on’, ’labelvis-
ible’, ’on’,’handlemode’,’multiple’
Latitude Longitude Label
...

Line

Property Description

group Name of the group.

linestyle Style of the line. (See Line Styles)

linewidth Width of the line.

linecolor R,G,B color spec.

visible Visibility of object. (‘on’ or ‘off’)

Location Data

A single line can be defined in a block. Each line of data defines a vertex. Lines are not

automatically closed.

line ‘group’,’line’,’linestyle’,’dash’,’linewidth’,’1’,’linecolor’,’1 0 0’,’visible’,’on’
Latitude Longitude
...

Ellipse

Property Description

group Name of the group.

linestyle Style of the line. (See Line Styles)

linewidth Width of the line.

linecolor R,G,B color spec.

visible Visibility of object. (‘on’ or ‘off’)

handlemode (‘multiple’ or ‘single’)

Location Data

A group of ellipses with the same properties can be defined in the same block. Each line of

data defines an ellipse.

ellipse ‘group’,’ellipse’,’linestyle’,’dash’,’linewidth’,’1’,’linecolor’,’1 0 0’,’visi-
ble’,’on’,’handlemode’,’multiple’
Latitude Longitude Major Minor Strike
...
84



Major: Length of major axes in kilometers.

Minor: Length of minor axes in kilometers.

Strike: Degrees clockwise from north.

Origin

Property Description

group Name of the group.

fontsize Size of label in points.

labelcolor R,G,B colorspec.

marker Style of the marker. (See Marker Styles)

markersize Size of marker in points.

edgecolor R,G,B colorspec.

facecolor R,G,B colorspec.

linestyle Style of the line. (See Line Styles)

linewidth Width of the line.

linecolor R,G,B color spec.

visible Visibility of object. (‘on’ or ‘off’)

labelvisible Visibility of label. (‘on’ or ‘off’)

Location Data

A group of origins with the same properties can be defined in the same block. Each line of

data defines an origin. The difference between an ellipse and an origin is that an origin can

also contain a point and a label at the center of the ellipse.

origin ‘group’,’origin’,’fontsize’,’12’,’labelcolor’,’1 0 0‘, ‘marker’, ‘point’,’marker-
size’,’12’,’edgecolor’,’1 0 0’, ‘facecolor’, ‘1 0 0’, ’linestyle’,’dash’,’line-
width’,’1’,’linecolor’,’1 0 0’,’visible’,’on’,’labelvisible’, ‘on’
Latitude Longitude Major Minor Strike Label
...

Major: Length of major axes in kilometers.

Minor: Length of minor axes in kilometers.

Strike: Degrees clockwise from north.

Patch

Property Description

group Name of the group.

edgecolor R,G,B color spec.

facecolor R,G,B color spec.

visible Visibility of object. (‘on’ or ‘off’)

Location Data

A single patch is defined in a block. Each line of data defines a vertex. Patches are automat-

ically closed.
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patch ‘group’,’patch’,’edgecolor’,’1 0 0’,’facecolor’,’1 0 0’,’visible’,’on’
Latitude Longitude
...

Surface

A surface defines a rectangular grid of color values.

If no path is specified and the filename contains a relative path, then the file is assumed to be

in the same directory as the file it was called from.

Property Description

group Name of the group.

shading How surface is drawn. (‘flat’,’texturemap’,‘interpolate’, or ‘con-

tour’)

visible Visibility of object. (‘on’ or ‘off’)

path Path in which to look for the file.

Location Data

A single surface is defined in a block. The line of data contains the path and filename of a

MATLAB MAT-file. The MAT-file must contain:

Variable Description

cdata MxN matrix of color values.

zdata MxN matrix of elevations.

lat Latitude range to plot surface.

lon Longitude range to plot surface.

cmap Colormap that cdata references.

surface ‘group’,’surface’,’shading’,’interpolate’,’visible’,’on’,’path’,’pathname’
filename

Trisurf

A trisurf is a sequence of locations with a value assigned at each location. These locations

are defined to be connected to one another by a connectivity matrix. Thus, the trisurf data

type is comprised of a surface or mesh of interconnected triangles in which the vertex of

each triangle has a defined value.

The markers are drawn at each location point with the lines drawn between the locations,

determined by the connectivity. The color value at each location can be used to form a gra-

diated color surface.

If no path is specified and the filename contains a relative path, then the file is assumed to be

in the same directory as the file it was called from.
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Property Description

group Name of the group.

linestyle Style of the line. (See Line Styles)

linewidth Width of the line.

linecolor R,G,B color spec.

marker Style of the marker. (See Marker Styles)

markersize Size of the marker in points

edgecolor R,G,B colorspec.

facecolor R,G,B colorspec.

shading How surface is drawn. (‘flat’,’texturemap’,‘interpolate’)

visible Visibility of object. (‘on’ or ‘off’)

path Path in which to look for the file.

Location Data

A single surface is defined in a block. The line of data contains the path and filename of a

MATLAB MAT-file. The MAT-file contains:

Variable Description

zdata N vector of elevations.

lat N vector of latitudes.

lon N vector of longitudes.

tri Nx3 connectivity matrix

cmap Colormap that zdata references.

trisurf ‘group’,’surface’,’linestyle’,’dash’,’linewidth’,’1’,’linecolor’,’1 0
0’,’marker’,’point’,’markersize’,’12’,’edgecolor’,’1 0 0’, ‘facecolor’,’1 0 0’,’shad-
ing’,’interpolate’,’visible’,’on’,’path’,’pathname’
filename

File

This type declaration is not an actual data type. It serves as a link to other mapfiles. This

allows multiple mapfiles to be linked together. If no path is specified and the filename con-

tains a relative path, then the file is assumed to be in the same directory as the file it was

called from.

Warning: Be careful not to recursively link mapfiles. Map Tool will go into an infinite loop

and keep reading the mapfiles until it runs out of system resources.

Property Description

path Path in which to look for the file.

Location Data

A group of files with the same path may be defined in the same block. Each line of data

defines a file.

file ‘path’,’path name’
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filename

Env

This type declaration serves to set environment variables inside of Map Tool

Property Description

The properties for the env data type are the same as environment variables defined at the

beginning of the Map Tool tutorial.

Location Data

There is no location data for this data type

env ‘property1’,’value1’,’property2’,’value2’...

Marker Styles

Marker Style Symbol

none none

point •

plus ✚
cross ✕
asterisk ❋ .

circle ●
square ■
diamond ◆
triangle-up ▲
triangle-down ▼
triangle-left

triangle-right

pentagram ★
hexagram ✶

Line Styles

Line Style Symbol

none none

solid 
dash – –

dot ···

dash-dot –·

▲▲
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Pulldown Menus

File Pulldown Menu

• Print - set the print options and print to a file or printer.

• Close - quit Map Tool.

View Pulldown Menu

• Properties - Set Map Tool properties. These properties control the appearance of the

Map Tool window. The map will automatically scale to fill the space available in the

main window. So, by turning off some of the visible features, more room can be allo-

cated for the map.

• Title - Set the title of the map.

• Land Color / Water Color / Coastline Color - set the color of the land, water,

and coastline. See the explanation on Colors at the end of this section.

• Show Grid Lines - Turn grid lines ‘on’ or ‘off.’

• Show Coastline - Turn coastline ‘on’ or ‘off.’

• Show Location - Turn mouse location indicator ‘on’ or ‘off’ The Value is the
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zdata value of the topmost surface beneath the current mouse location.

• Show Observed Great circle Paths - ‘on’ or ‘off’

• Show Theoretical Great circle Paths - ‘on’ or ‘off’

• Show Distance Range Circles (5,10,20,100 deg) - ‘on’ or ‘off’

• Show Zoom Buttons - Turn zoom (control) buttons ‘on’ or ‘off.’

• Show Data Buttons - Turn data buttons ‘on’ or ‘off.’

• Set Axes - Set the latitude and longitude limits.

• Zoom - Zoom In, Zoom Out, Full, Drag, Center, Undo, Update.
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• Projection - Set the map projection to be used, chosen from a list. When using the zoom

buttons to control the display of the map, it is recommended that a cylindrical projection

be used to zoom to the desired area of the world before changing projections. In some

projections (spherical projections in particular) the curvature of the latitude and longi-

tude lines can make zooming unpredictable. If the map gets into a severely distorted

state because of the chosen projection and viewing area, switch to a cylindrical projec-

tion and click on the Full zoom button. For additional details on the various map projec-

tions, see the Projections section.

Albers Equal-Area Conic
Azimuthal Equal-Area
Azimuthal Equidistant
Equidistant Cylindrical
Gall-Peters
Gnomonic
Hammer-Aitoff
Lambert Conformal Conic
Mercator
Miller Cylindrical
Mollweide
Oblique Mercator
Orthographic
Satellite
Sinusoidal
Stereographic
Transverse Mercator

• Colorbar - Set the visibility of the colorbar

• Colormap - Adjust the colormap for the overall display. This does not change the color-

maps of the individual surfaces, but merely adjusts how they are interpreted.
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Data Pulldown Menu

• Read - Read data from a file. Click on the File Name... pushbutton to browse for the file

or enter the path and file directly. The file must be in the mapfile format.

• Save - Save the current data points to an ASCII file in mapfile format.
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• Show - Set which data points, chosen from a list, are visible.

• Edit - Edit data point properties. There are two figures for editing data objects. One is

for editing a single data object and the other is for editing multiple objects.

1. Single Object Edit - Change the properties to their desired value and then

click Apply. Properties that do not apply to the current data object are grayed
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out. See the explanation on Locations and Colors at the end of this section.

2. Multiple Object Edit - Select the data points from the list to be changed. Set

the properties which are to be changed. A blank entry or “No Change” leaves

that property set to its original value. See the explanation on Locations and
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Colors at the end of this section.

• Delete - Delete data points. Select the data points from the list to be deleted.
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• New - Create a new data point. See the explanation on Locations and Colors at the end

of this section.
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Colors

Map Tool defines all of its colors through an R,G,B colorspec in which a three numbers

between 0 and 1 represent the amount of Red, Green, and Blue that must be combined to form

a given color. If an invalid R,G,B color spec is entered into the color field, then the color will

be stored as [ -1 -1 -1 ] and will be interpreted as ‘none.’

Map Tool provides the ability, through the use of the MATLAB® uisetcolor command, to

choose R,G,B colors from a colorwheel. Anywhere that a color property can be set, click on

the label to the left of the editing field to bring up the color wheel. Simply choose the color

desired and then click Ok. The property will be automatically updated with the new R,G,B

values.

Locations

Map Tool provides the ability, when editing or creating new objects, to enter location vectors

directly by selecting the locations on the map. Click on the Location... label to begin. The cur-

rent location value is automatically reset. On the map in the Map Tool figure, begin selecting

points. At each location selected, a point is drawn and lines are drawn between the points.

Also, the location value is update to include the new point. Note: for types point, scaled, ori-
gin, station, and ellipse, only one point is allowed. Each successive selection replaces the pre-
vious selection. For surfaces, at the end of point selection, the extreme ranges of latitude and
longitude are used to build the location vector. When the location selection is completed, click

again on the Location... label to end location selection. While the map is in location selection

mode, the Control Buttons are disabled.
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Data Popup Menu

Data popup menus are accessed by clicking on one of the individual data points displayed on the

map projection or by clicking on one of the group data buttons on the right side of the figure in the

Dataset Display.

Popup Menu

• Edit - Edit properties of the data object(s).

• Raise - Move data in front of overlapping data.

• Lower - Move data behind overlapping data.

• Show - Set data visibility ‘on.’

• Erase - Set data visibility ‘off.’

• Delete - Remove data point from display and from memory.

• <cancel> - Exit popup.

Origins have an additional entry in the Popup Menu

• Select/Unselect - Control the selected origin in MatSeis
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Control Buttons

• Zoom In - Draw a box which defines the area to zoom in to.

• Zoom Out - Enlarge the map display limits to twice the current size until the full size of

the map is reached.

• Full - Return the map to its full size.

• Undo - Sequentially “undoes” any operation using Zoom In, Zoom Out, Full, Drag,
and Center. Other settings such as projection type and map colors will remain the same.

• Center - Center the map on the location selected with the mouse.

• Drag - Draw a box whose corners define the old and new position of the map.

• GC - Draw a box whose corners define the beginning and end of the Great Circle path to

be drawn.

• Select Box - Create a selection box with the mouse which can serve to define a region or

select any objects that fall within the box. Other matlab programs can reference the

selection box.

• Update - Read in Origin and Station data from MatSeis and redraw plot.
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Projections

Map Tool supports 17 Azimuthal, Conic, and Cylindrical map projections.

Conformal refers to the map projection’s ability to preserve angles for differentially small regions.

Equal-Area refers to the map projection’s ability to preserve area.

• Albers Equal-Area Conic - Equal-area but not conformal. Primarily used to map regions of

large east-west extent. Parallels are unequally spaced arcs of concentric circles, more closely

spaced at the north and south edges of the map

• Azimuthal Equal-area - Equal-area but not conformal.
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• Azimuthal Equidistant - Neither equal-area nor conformal. Distances measured from the

center are true.

• Equidistant Cylindrical - Linear scaling of longitudes and latitudes. All meridians and paral-

lels are equally spaced straight lines.

• Gall-Peters
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• Gnomonic - Neither equal-area nor conformal. All straight lines on this map are great circle

routes. Radii should be kept to about 20 to 30 degrees in order to minimize distortion around

the edges.

• Hammer-Aitoff

• Lambert Conformal Conic - Conformal, but not equal-area.
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• Mercator - Cylindrical, conformal projection with no distortion along the equator. However,

distortion increases closer to the poles. Straight lines on this projection are rhumb lines.

• Miller Cylindrical - Neither equal-area nor conformal.

• Mollweide
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• Oblique Mercator - Conformal but not equal-area. Both parallels and meridians are complex

curves.

• Orthographic - Neither equal-area nor conformal. Resembles a perspective view of the globe

• Satellite - Perspective view of the earth, as seen by a satellite.
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• Sinusoidal - The central meridian is a straight line and all others are sinusoidal curves.

• Stereographic - Conformal, but not equal-area. Mainly for displaying polar regions.

• Transverse Mercator - The great circle of tangency lies along a meridian of longitude. There

is no distortion along the meridian.
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MatSeis Section 6:
Data Types

The Four Basic Data Types and Their Use

Matlab has four basic types of data: origins, waveforms, arrivals and travel times. A proper under-

standing of each of these is essential to fully take advantage of all that MatSeis has to offer.

For each of the data types, a general utility function is provided to query, edit, retrieve data from

MatSeis into matlab.These functions are written in C code linked through the cmex interface, thus

the data itself is stored in the C code, not in matlab. This is why you never see any of the MatSeis

data when you type “who” or “whos” in matlab. In this section we will discuss each of these and

provide examples of how to use them.

Origin

The origin data types holds all of the parameters associated with an event (origin time, lat, lon,

depth, mb, etc.). The corresponding waveform function is simply “origin”.

We will provide an example to show how to access information for a particular origin for which

we know the orid. Let this value be our_orid.

We first need to find the index corresponding to this orid (note that the index is not the same as the

orid: orid is assigned when the data is placed in the database whereas index is the index assigned

by MatSeis when the origin is read into memory). First get the indices of all origins:

   >>origin_indices = origin(‘index’)

Next get the orids of all origins:

   >>origin_orids = origin(‘orid’)

To find the index corresponding to our_orid, we can do this:

   >>our_index = origin_indices(find(origin_orids == our_orid))

A more compact (if also more confusing) version that requires only one step would be:

   >>our_index = find(origin(‘orid’) == our_orid)

Now we can get whatever information we want about our origin:

   >>our_mb = origin(‘mb’,our_index);

   >>our_locn = origin(‘location’,our_index)

Or we can select it or make it invisible:
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   >>origin(‘select’,our_index);

   >>origin(‘visible,our_index,0);

To see the full description of the origin function, type “help origin” at the matlab prompt.

Waveform

A MatSeis waveform is actually a combination of information corresponding to the waveform

such as station and channel name and sample rate, as well as information corresponding to the sta-

tion, such as location. The corresponding function is “waveform”.

Our first example will show how to extract into a matrix of column vectors the selected, win-

dowed waveforms in matseis.

First, we find the indices of the selected waveforms:

   >>waveform_indices = waveform(‘index’,’selected’);

Next we use these indices to extract the windowed data:

   >>waveform_data = waveform(‘data’,waveform_indices,’segment’);

waveform_data is an N x M matrix where N is the number of time points in each series and M is

the number of series. Note the semicolon here. This is the standard matlab notation to keep from

having the full matrix printed out to the screen. If you want to accomplish the whole thing in one

command, you could use:

   >>waveform_data = waveform(‘data’,’select’,’segment’);

To plot one of the waveforms, you could try:

   >>plot(waveform_data(:,1),’-r’);

As a second example, we will show how to add a waveform to MatSeis (and display it in the

Waveform Window). Suppose that our data is in a matlab array called our_data and that it has var-

ious parameters in the variables our_parametername. Here is what we do:

   >>new_index = waveform(’create’);

   >>waveform ( ’data’, new_index, our_data );

   >>waveform ( ’samprate’, new_index, our_samprate );

   >>waveform ( ’time’, new_index, our_start_time );

   >>waveform ( ’length’, new_index, lenth(our_data) );

   >>waveform ( ’station’, new_index, our_station_name );

   >>waveform ( ’channel’, new_index,our_channel_name);

   >>waveform ( ’location’, new, [our_lat our_lon our_elevation]);

That creates a new waveform and gets an index for it and then assigns the various properties asso-

ciated with the index. Now any action to redraw the screen should show the new waveform, e.g.

   >>ms_draw;
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To see the full description of the waveform function, type “help waveform” at the matlab prompt.

Arrival

The arrival data type is just what you expect. It provides all of the information about an arrival

(e.g. time, station & channel, arrival ID) and also its association information (which origin it is

associated with, if any). The corresponding function is “arrival”.

In our example, we will show how to fetch the indices for the arrivals associated with our origin

with orid our_orid and then how to use these to change the properties of the arrivals.

First, we get the indices for the associated arrivals:

   >>arrival_indices = find(arrival(‘origin’) == our_orid)

To get the arids for these arrivals:

   >>arrival_arids = arrival(‘arid’,arrival_indices)

To select them, first deselect everything:

   >>arrival(‘select’,arrival(‘index’),zeros(size(arrival(‘index’),1),1))

Then select the associated arrivals

   >>arrival(‘select,arrival_indices,ones(size(arrival_indices,1),1))

To see the full description of the arrival function, type “help arrival” at the matlab prompt.

Travel Time

The travel time data type is probably the least familiar, but we highly recommend learning to use

it as it is essential for many types of data processing. It contains all of the information associated

with the travel time curves for a particular phase (slowness, time, alignment). The corresponding

function is “travtime”.

In our example, we show how to align the display on the PcP travel time curve.

First, we find the index of the PcP curve:

   >>travtime_index = travtime(‘index’,’PcP’)

we then align:

   >>travtime(‘current’,travtime_index);

As a second example, we show how to find the theoretical time and slowness for the P phase at

distance our_dist for the current origin:

   >>our_time = travtime(‘time’, ‘P’, [origin(‘depth’,’current’) our_dist])
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   >>our_slow = travtime(‘slowness’, ‘P’, [origin(‘depth’,’current’) our_dist])

To see the full description of the travtime function, type “help travtime” at the matlab prompt.

What Next?

These four functions when combined with the basic functions offered by matlab and its various

toolkits should allow the user to develop virtually any type of functionality for seismic data. For

examples, the reader should refer to the numerous m-files in the MatSeis delivery. With these, you

have an abundance of examples to build upon and with a little effort you should soon be able to

build a variety of useful functionality of your own. Remember that because matlab is an inter-

preted language, you can essentially prototype at the command line, trying each new line of code

as you add it in.
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MatSeis Section 7:
Summary

While we realize that the user has seen only a relatively small portion of the functionality of the

software, he/she should have a good understanding of the basics. The software was designed to be

self-explanatory and easy to learn. Many of the types of operations and pop-up menus (Read,

Write, Show, Delete) are essentially the same for all 4 types of data, so once usage is learned for

one, the others should quickly follow.

The best way to learn MatSeis is to use it. Read in a test data set and try things. Setup your own

configuration file to learn how it is used. (Refer to the file ms_config.m for a complete list of mat-

seis environmental variables available for use). In fact, we recommend setting up configuration

files for each data set/application. Examine database files before, during, and after reads and

writes to see what is happening to them. Setup a travel-time table for your favorite phase. Exam-

ine the numerous m-files in the MatSeis directory and figure out how they work. (Short explana-

tions are given for each function available from a pulldown menu in Appendix A). Borrow

liberally from them to form functions of your own (and send them to us if they seem useful for

others!).

We feel confident that if the user is willing to invest a relatively small amount of time in learning

the system and (especially) the data formats, he/she will be well-rewarded.
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MatSeis Appendix A:
Pulldowns

The complete listing of all of the pulldowns is given below.

File

The options in File are used to setup, export data, restart, end, and print pictures of a MatSeis ses-

sion.

• Reconfigure - reconfigures to the startup configuration by reading the configuration file

(if used).

• Input Database Setup - sets input database type and parameters.

• Output Database Setup - sets output database type and parameters. Currently, only

flatfile is allowed.

• Export Flatfile Database - writes to origin, arrival, site, sitechan and wfdisc files spec-

ified in the Output Database Setup. (New origin and arrival indexes are generated using

the lastid table). Existing files can be appended, or new files can be created. Large data

sets can be segmented into smaller blocks using this feature, because for each export,

the wfdisc directory structure for each subgroup is updated to point to the correct direc-

tory location containing the master waveform files. This minimizes having several cop-

ies of the same waveform data.

• Print - sets the print options and print to a file or printer. Note that this tool can be used

to print ANY MatSeis tool (choose which figure you want to print from the popup-menu

in the tool). Note also, however, that printing from Matlab is notoriously buggy. We

often find the best option is to use a screen capture to frame, word, or powerpoint, and

then print from there.

• Close All Pop-ups - closes all popups associated with MatSeis. This is very handy if

you have an error in a GUI such that the figure has become invisible. but is still around.

Finding the handle to the invisible object so you can delete it can be a pain: if you think

you have such a situation just use this option.

• Restart - restarts MatSeis.

• Exit Matseis - pops up a GUI giving three exit options: 1) Exit Matlab and Matseis, 2)

Exit Matseis only 3) Cancel.
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View

The options in View are used to control the waveform window.

• Properties - pops up a GUI allowing the user to set various parameters controlling the

display.

• Resize Axes - adds resize handles to the axes so that individual portions of the display

can be resized.

• Zoom - access a full sub-menu of zoom choices

-> Undo - undo last zoom operation (hot key: <ctrl-u>).

-> Full - zoom to window big enough to show all visible travel time curves for

selected origin.

-> Origins - zoom to window big enough to show all visible origins.

-> Data - zoom to window big enough to show all visible data.

-> Refresh - redraw current view (hot key: <ctrl-l>).

-> In - provide cursor for drag-box zooming in X, Y and XY (hot key: <ctrl-z>).

-> Out - automatically unzoom by 150% in X, Y and XY (hot key: <ctrl-x>).

-> Drag - provide cursor for drag-box dragging to re-center the view in X, Y and

XY (hot key: <ctrl- d>).

-> Move - automatically re-center the display by moving half a screen in a given

direction, either Up, Down, Left or Right

• Set Axes - set the limits of the plot along the x-axis (time) and along the y-axis (dis-

tance).

• Time Alignment - there are three options in Time Alignment that are used to change

how the waveforms and phase curves are plotted.

-> Phase - chooses a phase on which to align the waveforms. The phase to be

aligned can also be changed by double-clicking on a phase in the graphics win-

dow or choosing align from the waveform pop-up menu.

-> Reduction Velocity - applies a reduction velocity in seconds per degree.

-> Reset - resets to no alignment. This can also be done by double-clicking the

phase on which the display is aligned.

• Map Tool - bring up the map tool with the origins and stations currently visible in mat-

seis.

• Alpha List - bring up a tool for displaying and manipulating the arrivals for any origin.



• Measure Tool - bring up a tool for detailed measurements of arrival times and various

associated amplitudes (hot key: <ctrl-m>).

• Free Plot - send selected, windowed waveforms to separate, non-epicentral-distance

controlled display. Waveforms in this display can be moved by left-clicking with the

mouse (hot key: <ctrl-f>).

• Screen Capture - make a quick-and-dirty plot of the main waveform window in its cur-

rent state. This can be handy if you want to compare say a waveform plot of one origin

with that of another.

• CSS FF Table Viewer - When using CSS FF database tables, select from the list of

CSS FF tables supported and if one exists the contents are displayed in a listbox for

viewing. When selecting the Origin Tables to view, the user can select rows from the

listbox and selecting Read Selected Origins button will read in the origins selected.

Associated arrivals can also be selected to be read at the same time as origins.

Orig

The options in Origin are used to read, write, select, delete, and display origin data. In addition we

provide additional options to facilitate moving between several different origins (Current Origin,

Next Origin).

• Read - reads origins from the input database to display in MatSeis. To get a list of ori-

gins in the database, choose a start and end time and click on the “Update” button. An

easy way to get the start and end times is to click on “Set Time to Axes”. A list of all the

origins in that time span will be displayed. The origins can be sorted by time, latitude,

longitude, depth and magnitude. Pick the origins you want to display in the graphics

window by selecting them individually or clicking on “Select All”. To read all of the

arrivals associated with a given origin, choose the “Read Arrivals” option.

• Write - writes origins to the output database (new orids are generated using the lastid

table), by either List or Selected methods. List selection is from a sortable list of all ori-

gins currently in memory, similar to the read list. Selected, writes just the currently

selected origin’s information to the output database files.

• Show - shows selected origin(s) from those in memory. This option allows the user to

display in the origin graphics window only the origins of interest without losing infor-

mation that has been read into MatSeis (as happens with Delete). Selection is from a

sortable list similar to the read list. Origins can be “unshown” (but not deleted!) by

right-clicking on an origin in the origin graphics window and choosing erase from the

pop-up menu.

• Delete - deletes some or all of the origins picked in Read. Origins can also be deleted by

right-clicking on an origin in the graphics window and choosing delete from the pop-up

menu.

• Select - picks the origin used for various operations (e.g. time and distance alignment).



Only one origin can be selected at a time. Selection is from a non-sortable list. Origins

can also be selected by right-clicking on an origin in the graphics window or choosing

select from the origin pop-up menu, or left-clicking the origin.

• New - creates a new origin. Origin information (e.g. location) can be edited by clicking

on the origin in the graphics window and choosing edit from the pop-up menu. Location

information can also be set from map_tool select box. The location is given as the center

from the select box.

• Current Origin - read in data for the current origin assuming the same stations and

channels. This is useful for network operators reviewing a series of events. Options

include either Keep data and Delete data (hot key: <ctrl-o>). Current Origin ->Keep

data will load the current origins data, keeping all data in memory. Current Origin -

>Delete data will load the current origins data, deleting existing origin data.

• Next Origin - read in data for next origin (in time) assuming the same stations and

channels. This is useful for network operators reviewing a series of events. Options

include either Keep data and Delete data (hot key: <ctrl-p>). Next Origin ->Keep data

will load the next origins data, keeping all data in memory. Next Origin ->Delete data

will load the next origins data, deleting existing origin data.

Wfm

The fourteen options in Waveform are used to read, write, select, delete, and display waveform

information.

• Read - selects network, station and channel information of the waveforms to be plotted.

Choose a network to get a list of stations and channels. The start time and duration will

set the limits on how much of the waveform is plotted. These values can be entered

manually or set by choosing “Set Time to Axes”. Note that MatSeis can be slowed down

considerably if too much data is requested. Each station has distance and azimuth infor-

mation that corresponds to the selected origin. Stations can be sorted by distance or azi-

muth. Pick the stations from which you want to display waveforms by selecting

individually or clicking on “Select All”. One or more channels must also be selected.

Other options to choose are to add or replace waveforms, ask for station locations only

(useful for View --> Map option), demean the waveforms, or zoom to data.

• Show - shows only selected waveform(s) without deleting the other waveforms picked

in Read. Works like Show for Origin. Waveforms can be erased by clicking on a wave-

form in the graphics window and choosing erase from the pop-up menu.

• Delete - deletes some or all of the waveforms picked in Read. Selection is from a sort-

able list similar to the read list. Choose either specific waveforms or specific station and

channel information to delete.Waveforms can also be deleted by right-clicking on a

waveform in the graphics window and choosing delete from the waveform pop-up

menu. Selected waveforms can be deleted using hot key: <ctrl-e>.

• Select - selects waveforms on which to do the signal processing. Selection is from a



sortable list similar to the read list. Waveforms can also be selected by right-clicking on

a waveform in the graphics window, then by choosing select from the waveform pop-up

menu, or left-clicking the waveform. Waveforms can be selected using hot key: <ctrl-

w> and drawing a rubber-band box to include waveforms of interest.

• Properties - pops up a GUI to allow editing of waveform display parameters (e.g. color,

amp) and channel name. The channel name option can be used to change the name for

copied and filtered data for clarification.

• Time Resolution - controls the resolution at which waveform is plotted (increase for

better resolution).

• Distance Resolution - controls rounding of epicentral distance for plotting (e.g. set to 0

for no rounding; set to 1 to round to the nearest degree).

• Display - two options:

-> Waveforms - turns waveform plotting on or off

-> Baselines - turns waveform baseline plotting on or off.

• Scaling - four options to change the scaling of the waveforms:

-> Global Fixed - relative scaling to the largest amplitude of any waveform on or

off the screen.

-> Global Automatic - automatically scales to equalize maximum zero to peak (or

trough) on or off the screen for each waveform.

-> On-screen Fixed - same as Global Fixed, but only considers portion of wave-

forms shown on screen.

-> On-screen Automatic - same as Global Automatic, but only considers portion

of waveforms shown on screen.

• Amp - changes the amplitude of all the waveforms via a pop-up with presets. The

amplitude of a particular waveform can be changed by clicking on the waveform in the

graphics window and choosing amp from the waveform pop-up menu.

• Offset - changes the offset (vertical, in degrees) of all waveforms via a pop-up with pre-

sets. The offset of a particular waveform can be changed by right-clicking on the wave-

form in the graphics window and choosing edit to get the edit waveform information

window.

• Clip - sets a normalized amplitude value above which all the waveforms will be clipped.

Useful for preventing high amplitude portions of certain waveforms from dominating

the display. To clip a particular waveform click on the waveform in the graphics window

and choose clip from the waveform pop-up menu.

• Color - assigns colors to all the waveforms. The default is white. If random is chosen



than all waveforms will be assigned a random color. The color of a particular waveform

can be changed by clicking on the waveform in the graphics window and choosing color

from the waveform pop-up menu.

• Line Style - changes the appearance of the lines (solid, dot, dash, dotdash, various sym-

bol types) used to plot all the waveforms. The symbols are useful for examining at an

individual digitization point level. The line style of a particular waveform can be

changed by clicking on the waveform in the graphics window, choosing edit from the

waveform pop-up menu, and selecting a style from the subsequent pop-up.

• Line Width - changes the width of the lines used to plot all the waveforms. The line

width of a particular waveform can be changed by clicking on the waveform in the

graphics window, choosing edit from the waveform pop-up menu, and selecting a width

from the subsequent pop-up

• Reset -returns all the waveform plotting parameters to the original values.

Arr

The options in Arrival are used to read, write, select, delete, and display arrival information.

• Read - reads arrivals from the database to display in the graphics window. To get a list

of arrivals in the database, choose a start and end time and click on the “Update” button.

An easy way to get the start and end times is to click on “Set Time to Axes”. A list of all

the arrivals in that time span will be displayed. The arrivals can be sorted by arid, orid,

station, channel, phase, or time. Pick the arrivals you want to display in the graphics

window by selecting them individually or clicking on “Select All”. Note: you can also
read in all of the arrivals associated with a given event by choosing the “Read Arrivals”
option in the Read option of the Origin pulldown.

• Write - writes arrivals to the database (new arids are generated using the lastid table).

Selection is from a sortable list of all arrivals currently in memory, similar to the read

list.

• Show - shows selected arrival(s) from those in memory. This option allows the user to

display in the graphics window only the arrivals of interest without losing information

that has been read into MatSeis (as happens with Delete). Selection is from a sortable

list similar to the read list. Arrivals can be “unshown” (but not deleted!) by clicking on

an arrival in the graphics window and choosing erase from the pop-up menu.

• Delete - deletes some or all of the arrivals in memory. Arrivals can also be deleted by

clicking on an arrival in the graphics window and choosing delete from the pop-up

menu. To delete selected arrivals quickly, use the hot key: <ctrl-g>.

• Select - arrivals can be selected several ways: list, by using mouse, associated, on-

screen, all or none. Selecting arrivals from a sortable list; list types are by station &

channel, or arrivals. By using mouse is done using the hot key: <ctrl-a>, and drawing a

rubber-band box around the desired arrivals. Associated, selects all arrivals associated



with the currently selected origin. On screen selects all arrival currently displayed

within the waveform window.

• Associate - pops up a GUI with lists of the arrivals and origins to allow the user to form/

change associations. Left-double click to associate/unassociate arrivals to waveforms,

center-click to open the arrival edit pop-up menu.

• Default Phase - sets the default phase name used when picking arrivals. Phase names

can be changed by clicking on the arrival in the waveform window and selecting the edit

option from the pop-up, but when picking many of the same phase at once (e.g. P) it is

much quicker to set the default type first.

• Pick Travel-times - automatically makes a pick for every shown phase for every shown

waveform at the theoretical arrival time. The option is given to apply an elevation cor-

rection to the picks made. The user can also specify the P and S wave surface velocity to

use for this correction factor. Useful for generating test/demo data sets. The choice

exists to apply elevation corrections, simply edit the P and S wave surface velocity to the

desired values and select the Apply Elevation Correction checkbox and select Apply.

• Arrival Travel-time - pops up a GUI for plotting relative arrival time against epicentral

distance between station and origin. The GUI lists the number of Origins currently

loaded in MatSeis, and the number of Arrivals currently loaded in MatSeis. Since the

origins will not have occurred at the same depth, the user can select a depth to shift to,

along with a button to control if this is done. An edit box is provided to set a comma

separated list of phases to plot. Click Apply to do the calculation. Origins are plotted in

3-dimensions so that the Rotate option can be used in viewing.

TT

The options in Travel-time are used to read and display travel-time curve information.

• Read - picks selected phases from user definable data files of travel-time information

that are plotted against the selected origin. Three different formats are available. Choose

the format and specify the location of the files first. Then specify a phase list file to get a

list of phases to pick from (this controls the size of the list). Pick the phases you want

from the list by clicking individually or clicking “Select All”.

• Write - write out travel-time tables.

• Show - shows only selected phase curve(s) without deleting the other phase curves

picked in Read. This option allows the user to display in the graphics window only the

phases of interest without losing information that has been read into MatSeis (as hap-

pens with Delete). Phases can also be picked not to be shown by clicking on a phase in

the graphics window and choosing erase from the pop-up menu.

• Delete - deletes some or all of the phase curves in memory. Phases can also be deleted

by clicking on a phase in the waveform window and choosing delete from the pop-up

menu.



• Select - select a travel time curves from a pop-up list. Curves can also be selected

(aligned) by left-double clicking on a curve in the graphics window. Center-clicking

opens the slowness pop-up menu.

• Display - two options:

-> patches - turns travel time curve plotting on or off

-> Baselines - turns travel time curve baseline plotting on or off.

• Width - pops up a GUI allowing the user to change the width of the travel time curves.

• Colors - assigns colors to all the phase curves. The default is gray. If random is chosen

than all phase curves will be assigned a random color. The color of a particular phase

can be changed by clicking on the phase in the graphics window and choosing color

from the pop-up menu.

Meas

The options in Measure are used for detailed measurements of arrival times and various associ-

ated amplitudes measurements.

• Auto Measure - popup GUI for selecting a Recipe File, which define parameters for

automatically picking amplitude and period magnitude calculation and click Apply.

• Measure Tool - popup GUI to add and modify arrival picks. This tool has waveform fil-

tering, arrival and measurement section. Measurement section refers to waveform char-

acteristics used in magnitude calculation: amplitude and period. This tool is discussed in

the tutorial.

SigPro

The options in Signal Processing are used to set up and run signal processing algorithms.

• Options - chooses to replace waveforms or create new ones. If new ones are created

they will be plotted at the same epicentral distance as the originals in the event-tied dis-

play mode. New waveforms will have a suffix added to the original name dependent on

the type of processing.

• Time Segment - picks the time interval over which the signal processing will be done.

Either the whole waveform or a time segment can be chosen. A time segment can be

selected by setting start time and duration, by setting the time to axes, or by using a rub-

ber-band box to define the time segment on the graphics display (hot key: <ctrl-s>). The

time segment can be turned off using the hot key: <ctrl-q>.

• Filters - designs and implements different filters. The time segment over which the filter

is applied is defined in Time Segment.

-> Design - pops up a GUI which lets the user design a filter by choosing filter



type, band type, cutoff frequency and order. The user can also plot the fre-

quency response, impulse response and poles of this filter.

-> STA/LTA - lets the user set the parameters for a STA/LTA detector (average

type, width and delay) and plot the step response and window placement.

-> Prediction Error - lets the user set the parameters for a LMS adaptive predic-

tion error.

• Operations - applies arithmetic operations to the selected waveform(s). The time seg-

ment over which the operations are applied is defined in Time Segment.

-> Custom Function - allows the user to apply a custom function to a selected

waveform and specify the name for the new channel which will be created.

-> Absolute Value - calculate waveform absolute values.

-> Add DC Offset - add a dc offset to the waveform.

-> Apply Gain - apply a gain as set by the user to the waveform.

-> Clip - lets the user set a clip threshold and set clip type to be above or below the

threshold. Unlike the “Clip” option in the Waveform pulldown, this function

will actually clip the data rather than just show it as clipped.

-> Negate - changes the polarity of the waveform.

-> Sign - calculate sign (plus or minus 1) of waveform.

-> Square - squares waveform.

-> Square Root - calculate square root of waveform.

-> Hilbert Envelope - apply Hilbert transform to waveform.

-> Power - apply a power as set by the user to waveform.

-> Demean - remove mean value from waveform.

-> Detrend - remove a linear trend from waveform.

-> Difference - calculate sample-to-sample difference for waveform.

-> Derivative - differentiate waveform.

-> Downsample - downsample the waveform by a factor set by the user.

-> Integral - integrate waveform.

-> Window - lets the user choose a window type to multiply the data with. The fre-

quency response of the window can be plotted.



• Time Functions - applies different timing functions to the selected waveform(s).

-> Cut Time Segment - lets the user cut out a specific time segment. Time Segment

must be on.

-> Time Shift - lets the user time shift the selected waveform(s) by a specific num-

ber of seconds.

-> Resample - lets the user resample the waveform to a new sample rate.

• Multi-Waveform - performs operations that combine two or more waveforms. The

waveforms that are produced are called SUM, PROD or stachan#. They are plotted at a

distance that is an average of the distances of the stations that are combined.

-> Sum Waveforms - sums two or more waveforms.

-> Multiply Waveforms - calculate product of two or more waveforms.

-> Concatenate Waveforms - concatenate two or more waveforms in time.

• Three-Component - perform three-component processing

-> Rotate - rotate the data to form rotated components. Rotation can either be in

horizontal plane only, or full.

-> FK3C - creates an FK-like display of linearized power vs. total power; useful

for verifying arrivals.

• Array - performs array processing.

-> General Beam - forms standard time delay beams for array data (if site,

sitechan, and affiliation are setup correctly). A pop-up menu will allow the user

to specify azimuth as a single value or range of values (e.g. 0:15:360 means 0

to 360 every 15 degrees), Slowness as a single value or set of values, or you

can use “Set to Origin” to form origin beams for all phases (travel-time curves)

shown. Output is either a set of standard beams (Beam Set), a set of beam pow-

ers (Beam Set Power, this is the squared output), or a single beam which is the

maximum beam power on any beam in the set at each time point (Max Beam

Power).

-> Event Beam - forms standard time delay beams for array data (if site, sitechan,

and affiliation are setup correctly). The Azimuth edit box is set to the station to

event azimuth. The Phase edit box lists the phase names of the travel time

curve(s) contained within the waveform segment window. Output is a standard

beam waveform and displayed in the waveform window.

-> FK - pops up a GUI controlling the creation of an FK for the windowed data

for the selected array channels. The user can specify slowness parameters, fre-

quency band, window type, and plotting options.



-> Fast FK - pops up a GUI controlling the creation of a Fast FK for the win-

dowed data for the selected array channels. The user can specify slowness

parameters, frequency band, window type, and plotting options.

-> Vespagram - pops up a GUI controlling the creation of a vespagram for the

window data for the selected array channels. A vespagram is a plot of slowness

vs. time (azimuth is constant). The user can specify the slowness parameters,

time discretization, and a clipping factor.

-> Spatial Coherence - produces a single output stream for multi-channel/multi-

station data using Greg Wagner’s spatial coherence algorithm (principal eigen-

values from decomposition in the frequency domain). A pop-up will show the

number of channels selected and prompt the user for window size (in points),

and window overlap (%), as well as whether glitch elimination (based on con-

tribution to the trace of the covariance matrix) should be used.

-> Data Synthesis - form synthetic array data for testing purposes. Delays will be

for selected origin and specified phase.

-> Array Response - calculates FK array response.

-> Arrival Transfer - pops up a GUI for selecting an arrival, which then updates

Waveform(s) for Transfer and Channel listboxes for available data. Transfers a

selected arrival to a selected waveform when Apply is selected.

• Transfer Tool - lets the user deconvolve and/or convolve instrument responses for a

selected waveform and send resultant waveform back to MatSeis. Current version can

read both CSS format instrument response files as well as SEED format instrument

response files.

• Power Spectral Density - lets the user choose the overlap and window type and com-

putes power spectral density(s) for the selected waveform(s) and plots them in a second

window. This window can be printed. When animation mode is used steps 1-6 can be

set, so displayed when enabled.

• Spectrogram - lets the user choose the overlap and window type and computes spectro-

gram(s) for the selected waveform(s) and plots them in a second window. Color bars are

also plotted. This window can be printed. Animation function now exists.

• Cepstrum - lets the user choose the FFT length and window type and computes cep-

strum for the selected waveform and plots them in a second window. This window can

be printed.

• Analyzer Tool - Lets the user use several algorithms to analyse either single or multiple

waveforms from array, or 3-component data. Set the window length in seconds and the

% overlap desired for the waveform segment chosen. The algorithms are:

-> STA/LTA - sort term to long term window ratio.



-> Amplitude - the amplitude is the magnitude of the data window for the multi-

channel waveforms. For each window, a covariance matrix is computed for the

waveform channels. The amplitude of that window is then calculated as the

trace of the covariance matrix.

-> Skewness - measure of how evenly distributed the signal is.

-> Kurtosis - measure of how Gaussian the signal is.

-> Projection 1 - the projection of the multi-channel data onto the principle eigen-

vector of the covariance matrix. The data window for this covariance matrix is

set by the adjustable purple patch.

-> Projection 2 - the projection of the multi-channel data onto the second eigen-

vector of the covariance matrix. The data window for this covariance matrix is

set by the adjustable purple patch.

-> ARC Gradnw - the change in Auto regressive (AR) Model coefficients between

step i and i+1. Data "Window" equals M (AR Order). Data window NOT

effected by GUI Window controls. For 2 or 3 component seismograms, ARC

returns SUM(ARC(Z), ARC(N), ARC(E)). The ARC algorithm as described in

(2) does not average and thus using steepest decent algorithm uses just M (the

model order) inputs in calculation of AR coefficients at each time increment.

References: 1- Kay, S., "Modern Spectral Estimation" Prentice Hall, 1987 2-

"Identification and Picking of S Phase Using an Artificial Neural Network,

Bulletin Seismalogical Soc. Of Amer., Vol. 87, No. 5, Oct. 1997

-> ARC Burg - the change in Auto regressive (AR) Model coefficients between

step i and i+1, Burg method. For 2 or 3 component seismograms, ARC returns

SUM(ARC(Z), ARC(N), ARC(E)). Uses the length(window)-1 to calculate

a(i-1) and length(window) to calculate a(i). ARC is then returned as single

value (a(i)-a(i-1))/a(i). NO averaging here. References: 1- Kay, S., "Modern

Spectral Estimation" Prentice Hall, 1987

-> ARCselnw - uses ONLY selected (one) waveform, The change in Auto regres-

sive (AR) Model coefficients between step i and i+1. Data "Window" equals M

(AR Order). Data window NOT effected by GUI Window controls.

Corr

The options in Correlation are used to perform various correlations of waveforms.

• Waveform Correlation Tool - pops up a tool facilitating comparison of two selected

waveforms. Select two waveforms and set a processing window using <ctrl-s>, then

launch the tool. The interactive display will show the superimposed waveforms and the

cross-correlation stream.

• Multi-waveform Correlation - forms a correlation table for all selected waveforms (2

or more). Select two or more waveforms and set a processing window using <ctrl-s>,



then launch the tool. A n x n table will popup (n is the number of selected waveforms)

showing the maximum correlation values (normalized by the auto correlations) for each

pair. Note that the diagonals (waveforms with themselves) are 1 by definition.

Detn

The options in Detection are used either to process waveforms to facilitate detection or to actually

create detections.

• STA/LTA - lets the user set the parameters for a STA/LTA detector (average type, width

and delay), plot the step response and window placement, and apply it to the selected,

windowed data. Select one or more waveforms (and set a processing window using

<ctrl-s> if you like) and launch the tool. The GUI allows you to design and STA/LTA

type filter to apply to the waveforms. Once you have the parameters set, select Apply to

create the new waveforms, which will have “S/L” appended to the channel names.

• Trigger Tool - brings up a popup to allow the user to design a trigger to create detec-

tions (arrivals) for selected windowed streams. Typically, this would be used on wave-

forms created by STA/LTA. Launch the tool and a GUI will appear with various

parameters to set to control the triggering and name of the arrivals that will be added.

When you are satisfied with the settings select Apply and the arrivals will be added to

the selected waveform in the MatSeis Waveform Window.

Locn

The options here are used for event location

• MS Locator Tool - popup GUI to locate an origin. This tool is discussed in the tutorial.

• Arrival Order Tool - popup GUI to locate origin solely based on the order of the arrival

times, without using the travel-time tables. You will need a selected origin and associ-

ated arrivals. Launch the tool and you will get a GUI allowing you to choose the origin

you want to select (you can choose a different one) and which of the phases you want to

use, as well as the latitude and longitude extent and increments of the Earth you want to

search for the location. When you have things set as you want, choose Apply to see the

resultant map. The more stations and more arrivals you have the sharper the location

will become.

• Differential Phase Locator - popup GUI to select phases to use in computing the sta-

tion to event distance from travel-time tables based on phases selected (Usually

described as “Method of Circles” in epicenter location). Either two or three phases can

be selected. Clicking Apply draws a circle around the stations with selected phases, the

radius of which is based on the (Phase 1 - Phase 2) arrival time difference interpolated

from travel-time tables to a epicentral distance. The intersection of the circles, using

three or more stations, yields the event epicenter.

• Depth Phase Tool - popup GUI to find pP phases in seismic data using phase shift

deconvolution, simple deconvolution and auto correlation. This tool tries to find pP by



deconvolving direct P out of a set of waveforms and then stacking the waveforms to

enhance the pP arrival. You will need a selected origin and selected associated wave-

forms, and you must have P and pP (and only these) travel time curves in MatSeis. For

the stacking, the tool will align on either the theoretical P or picked P.

Mag

The options here are used for calculating magnitudes

• Magnitude Tool - popup GUI to calculate the network magnitude for the specified

arrivals of an origin. This tool is described in the tutorial.

• Duration Magnitude Tool - popup GUI to calculate network magnitude for the current

origin based on having made duration, ‘DUR’, picks on waveforms. An easy way to add

the DUR pick is to use Arr->Default Phase. Edit the Arrival Default window to ‘DUR’

and click Apply. Then use Add Arrival to place and associate the duration picks to

waveforms.

Dscrm

The options here are used for discriminating event types. (Currently unavailable for public distri-

bution).

Clust

This pulldown contains various tools for applying cluster analysis to events. (Currently unavail-

able for public distribution).

LP

This pulldown contains tools for analysis of surface wave data. (Currently unavailable for public

distribution).

Infra

This pulldown contains tools for analysis of infrasound data.

• Infra Tool - popup GUI to process infrasound array data to determine portions of high

correlation and to derive velocity and azimuth information which can be sent to the

Map Tool to locate events.

Hydro

This pulldown contains tools for analysis of Hydroacoustic data.

• Hydro Tool - popup GUI to process hydroacoustic array data to determine portions of

high correlation and to derive velocity and azimuth information which can be sent to the

Map Tool to locate events.



AV

The options here send arrival, or origin information to Arc View. (Currently unavailable for public

distribution.)

Peer Menu

A dynamically updated menu of functions that other tools on the Peer-to-Peer com munication

network provide.Because this menu is updated at runtime,its exact contents refl ect which tools

are currently running and what functions those tools provide.The fi rst level of menus are the

names of the other tools.The second level,below each of the tools,lists the specific func tions that

the tool provides. The functions that Matseis provides to other tools are as follows:

• Reconfigure - reconfigure using the provided MatSeis configuration file.

• Run Matlab Script - Run provided matlab script file. Script file generally used to exe-

cute either matlab or matseis style commands (see Section 6 Data Types for examples),

as one might do from the command line. This is generally used in automated processing,

or for demonstration purposes.

• Load Waveform Data - Load waveform data for selected origins in Dendro. Requiers a

valid input database setup and dendro station defined for database reference.

• Get Origins - Retrieve the selected, or all if none selected, origins from Dendro or KB

Navigator.

• Send Origins - Transfer the selected, or all if none selected, origins to Dendro or KB

Navigator.

• Get Arrivals - Retrieve the arrivals , or all if none selected, associated to origins in Den-

dro or KB Navigator.

• Send Arrivals - Transfer the arrivals, or all if none selected, assocaited to origins in

Dendro or KB Navigator.

(Peer-to-Peer communication is currently unavailable for public distribution.)

Help

This pulldown supplies the user with access to the Matseis users manual as well as information

about the version of Matseis being run.

• Matseis Manual - launches the Matseis users manual using acrobat reader.

• Regional Tools - launches the Regional Tools user manual (currently not available in

public distribution).

• About Matseis - popup GUI giving the version of MatSeis being run.
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MatSeis Appendix B:
Data Pop-ups

There are four types of data objects in MatSeis and each has a pop-up menu or a series of pop-up

menus which can be accessed by clicking on the data object. These pop-ups allow the user to

review/edit various properties of the object and perform various functions on it. The pop-ups for

each of the four types are shown below.

bold = function; italics = property

Origin

• origin ID - unique ID # for each origin

• select/unselect - for origin operations

• edit - pop-up menu of editable origin properties

• origin ID
• event ID
• time (origin)
• latitude
• longitude
• depth
• semi-major axis
• semi-minor axis
• strike (deg)
• mb
• ms
• ml
• number associated phases
• number defining phases (for location purposes)
• algorithm (location program)
• author
• comment
• load date

• raise - move in front of other overlapping origins

• lower - move behind overlapping origins

• erase - remove origin from display but not from memory

• delete - remove origin from display and from memory

• <cancel> - exit pop-up
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Waveform

• station name
• select/unselect - for waveform operations

• amp - of displayed waveform

• color - of displayed waveform

• edit - pop-up menu of editable waveform and station properties

• station
• channel
• start time - of displayed waveform

• latitude - of station

• longitude - of station

• elevation - of station

• amplitude - of displayed waveform

• offset - vertical offset of displayed waveform

• clip level - of displayed waveform

• color - of displayed waveform

• line style - of displayed waveform

• line width - of displayed waveform

• add arrival - add an arrival with the default phase name at the point where you left-

clicked to access the pop-up

• raise - move in front of other overlapping waveforms

• lower - move behind overlapping waveforms

• erase - remove waveform from display but not from memory

• delete - remove waveform from display and from memory

• <cancel> - exit pop-up

Travel-time

• phase name
• align/unalign - align display on travel-time curve

• color - of displayed travel-time curve

• width - of displayed travel-time curve in seconds

• slowness - display the slowness at the point on the travel-time curve where you left-

clicked to access the pop-up

• raise - move travel-time curve in front of other overlapping curves

• lower - move travel-time curve behind overlapping curves

• erase - remove travel-time curve from display but not from memory

• delete - remove travel-time curve from display and from memory

• <cancel> - exit pop-up

Arrival

• arrival ID - unique ID # for each arrival

• associate/unassociate - associate/unassociate the phase with the an origin. Origin must

be selected to associate.

• phase - of the arrival



• move - retime arrival. Cross cursor will appear and time will be displayed next to phase

name. Left-click to choose new time.

• edit - pop-up menu of editable arrival and station properties (from top to bottom; left to

right)

• arrival ID
• station
• channel
• signal type
• time - arrival time
• standard deviation - picking accuracy of phase (= deltim from arrival table)
• residual = observed time minus predicted time
• location defining - T/F: was this pick used to locate the event?
• azimuth - arrival station to event azimuth
• standard deviation - picking accuracy of phase (= deltim from arrival table)
• residual = observed time minus predicted time
• location defining - T/F: was this pick used to locate the event?
• slowness - arrival slowness
• standard deviation - picking accuracy of phase (= deltim from arrival table)
• residual = observed time minus predicted time
• location defining - T/F: was this pick used to locate the event?
• emergence angle
• residual
• rectilinearity
• first motion (short period)
• first motion (long period)
• origin ID
• phase
• phase confidence
• amplitude
• period
• log (amp/per)
• magnitude
• standard deviation
• mag type
• net mag defining
• snr - signal to noise ratio
• onset quality
• clipped data
• location weight
• velocity model
• author
• comment

• load date

• raise - move arrival in front of overlapping arrivals

• lower - move arrival behind overlapping arrivals

• erase - remove arrival from display but not from memory
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• delete - remove arrival from display and from memory

• <cancel> - exit pop-up
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MatSeis Appendix C:
Buttons

At the bottom of the MatSeis display are five groups of button used for zooming and translating

the reference frame. Each of these is described below.

ZOOM

• Undo - sequentially “undo” any operations using ZOOM, IN, OUT, DRAG or MOVE.

• Full - return to the full window.

• Origins - replot the graphics window around the origins that have been read in.

• Data - replot the graphics window around the data that has been read in. Typically used

when no origin is selected. This feature is also valuable when adding or multiplying

waveforms.

IN

• XY - pick a box in xy space which changes the limits of both x and y that are displayed

in the graphics window.

• X - pick a line in x space which changes the limits of x that is displayed in the graphics

window.

• Y - pick a line in y space which changes the limits of y that is displayed in the graphics

window.

OUT

• XY - enlarge the graphics window to 200% (X2) of the current limits in both the x and y

direction.

• X - enlarge the graphics window to 200% (X2) of the current limits in the x direction.

• Y - enlarge the graphics window to 200% (X2) of the current limits in the y direction.

DRAG

• XY - draw a box in xy space whose corners define the old and new position of a data

point, i.e. you “drag” a feature to where you want it to be displayed.
130



• X - pick a line in x space to define the drag.

• Y - pick a line in y space to define the drag.

MOVE

• Up - move the graphics window up by an amount equal to 1/2 of the total of the y axis.

• Down - move the graphics window down by an amount equal to 1/2 of the total of the y

axis.

• Left - move the graphics window to the left by an amount equal to 1/2 of the total of the

x axis.

• Right - graphics window to the right by an amount equal to 1/2 of the total of the x axis.
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MatSeis Appendix D:
MatSeis Environmental Variables

A huge number of the settings in MatSeis are controlled by UNIX environmental variables which

can be set in the matseis startup script (e.g. run_matseis) as well as in the configuration (config)

files. Using these properly, a user can design a config file which will have MatSeis start up with

virtually everything set properly to begin analysis. Here we describe only the most used ones. For

a complete list, type ms_par at the matlab command prompt after starting Matseis.

MS_ORID A comma separated list of orids. If this list is set in the
config file, then these orids will automatically be read in
at startup.

MS_STA A comma separated list of stations. If this list is set in the
config file, then the corresponding waveforms (formed by
combination with MS_CHAN) will automatically be read
in for the first orid in the MS_ORID list.

MS_CHAN A comma separated list of channels. As above for
MS_STA.

MS_PHASE A comma separated list of phase names. If this list is set
in the config file, then the corresponding travel time
curves will be read in at startup (assuming the corre-
sponding tables exist).

MS_TIME A comma separated two element vector specifying the
start time and duration of the MatSeis Waveform Win-
dow. If specified in the config file, MatSeis will automati-
cally zoom to this time window at startup.

MS_CONFIG_FILE The name (including path) of the config file that will be
used when reconfiguring. Typically this is the one envi-
ronmental variable that is set in the user’s startup script
for MatSeis. All other variables are set in the config file
itself.

MS_AUTOMEAS_RECIPE The name (including path) of the recipe file that will be
used when making auto measurements of amplitude/
period for magnitude calculations.

MS_BG_COLOR A 3 element comma separated list of rgb values (ranges
from 0=black to 1=full color) specifying the MatSeis back-
ground color.

MS_FG_COLOR As above but for the foreground color.

MS_AX_COLOR As above but for the axes and the associated labels.
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MS_FONTSIZE A single integer specifying the point size of the font used
for labelling the MatSeis display.

MS_GUI_FONTSIZE As above but for the fonts used in the various popup
GUIs.

MS_GUI_FONTWEIGHT As above, but a string specifying the font weight. Accept-
able values are: normal or bold.

MS_W_AMP A single float value specifying the maximum amplitude (in
pixels) of the waveforms displayed in MatSeis. The
default value is 20.

W_SAMPLES This is single integer specifying the waveform time reso-
lution. Regardless of the sample rate, at some scale, sev-
eral points will end up being plotted at the same position;
this variable controls how many will be plotted and thus
improves performance without affecting visual percep-
tion. The default value is 1000.

MS_TT_TYPE A string specifying the type of travel time data read in.
Allowable values are: LOCSAT, TTMATRIX, and MAS-
TERIMAGE. The default values is LOCSAT.

MS_TT_WIDTH A single float specifying the width in seconds of the travel
time curves plotted in MatSeis.

MS_LOCSAT_DIR An unfortunate name for a string specifying the location
of the LOCSAT format travel time tables.

MS_LOCSAT_PREFIX A string specifying the prefix for the LOCSAT travel time
tables. The tables should all have the form: pre-
fix.phase_name, e.g. iasp91.P, iasp91.PcP, etc.

MS_TTMATRIX_DIR A string specifying the location of the TTMATRIX format
travel time tables. In this case we don’t need a prefix
because the files are assumed to be just the phase
names, e.g. P, S, etc.

MS_MASTERIMAGE_FILE A string specifying the default TT master image file.

MS_ARRIVAL_DEF A string specifying the default phase name that will be
used for picking arrivals. Default is UNK.

MS_DATABASE A string specifying the type of input database. Allowable
values are: LOCAL, CSS_SQL, CSS_FLATFILE

MS_DB1_DIR A string specifying the location of the LOCAL format input
database. Table names are assumed not to include a
prefix (e.g origin, channel, site) so none need be speci-
fied.

MS_DB2_SQLPLUS A string specifying the sqlplus-type command used to
query the input database. e.g. sqlplus

MS_DB2_USERNAME A string specifying the username for the input database
account to be accessed.



MS_DB2_PASSWORD A string specifying the password for the input database
account to be accessed.

MS_DB2_DATABASE A string specifying the name of the input database to be
accessed.

MS_DB2_AFFILIATION, AMPLITUDE, ARRIVAL, ASSOC, EVENT, INSTRUMENT, LAS-
TID, NETWORK, ORIGERR, ORIGIN, REMARK, SENSOR, STAMAG, SITE,
SITECHAN, WFTAG, WFDISC

In each case, a string specifying the name of the corre-
sponding CSS3.0 format table name for the input data-
base account.

MS_DB3_DIR A string specifying the location of the directory containing
the CSS3.0 flatfile input database tables.

MS_DB3_DATABASE A string specifying prefix used in the formation of the
CSS3.0 flatfile database table names. E.g if the tables
are mydata.origin, mydata.arrival, etc., this variable
would be mydata

MS_DB3_AFFILIATION, AMPLITUDE, ARRIVAL, ASSOC, EVENT, INSTRUMENT, LAS-
TID, NETWORK, ORIGERR, ORIGIN, REMARK, SENSOR, STAMAG, SITE,
SITECHAN, WFTAG, WFDISC

In each case, a string specifying the name of the corre-
sponding CSS3.0 format table name suffix for the input
flatfile database.

MS_OUT_DATABASE A string specifying the type of output database. Allowable
values are: CSS_FLATFILE only at this time.

MS_OUT_DB3_DIR A string specifying the location of the directory containing
the CSS3.0 flatfile output database tables.

MS_OUT_DB3_DATABASE A string specifying prefix used in the formation of the
CSS3.0 flatfile output database table names. E.g if the
tables are mydata.origin, mydata.arrival, etc., this vari-
able would be mydata

MS_OUT_DB3_AFFILIATION, AMPLITUDE, ARRIVAL, ASSOC, EVENT, INSTRU-
MENT, LASTID, NETWORK, ORIGERR, ORIGIN, REMARK, SENSOR, STAMAG, SITE,
SITECHAN, WFTAG, WFDISC

In each case, a string specifying the name of the corre-
sponding CSS3.0 format table name suffix for the output
flatfile database.

MS_SASC_DIR_PREFIX A string specifying the location of the Slowness Ampli-
tude Source Correction (SASC) files used by the locator
tool. Location does not require the use of SASC data.

MS_LOCATOR_UPDATE_DEF A flag (0 or 1) to control whether after each location the
old origin information is updated (1) or a new origin is



created (0).

MS_INFRA_FILE Specify a valid directory location to write Infra Tool pro-
cessing results and detection file.

MS_HYDRO_FILE Specify a valid directory location to write Hydro Tool pro-
cessing results and detection file.

MS_MAP_WATER_COLOR A 3 element comma separated list of rgb values (ranges
from 0=black to 1=full color) specifying the water color
displayed in map tool.

MS_MAP_COAST_COLOR As above, but for the color of the line used to draw the
coast.

MS_MAP_LAND_COLOR As above, but for land color.

MS_MAP_COAST_WIDTH An integer value specifying the width of the line used to
draw the coast. Default is 1.

MS_MAP_GRIDLINES A string (on, off) to specify whether or not to draw grid
lines on the map.

MS_MAP_LOCTION A string (on, off) specifying whether or not to automati-
cally show the lat, lon position of the cursor in the map.
Default is off.

MS_MAP_GCTHEO A string (on, off) specifying whether or not to draw great
circle paths connecting the selected origin and the sta-
tions with waveforms or arrivals.

MS_MAP_GCOBS As above, but to draw great circles using the azimuth
information with arrivals and slowness coming from the
travel time curves.

MS_MAP_RANGE A string (on, off) specifying whether or not to draw small
circles as 1 degrees, 5 degrees, 20 degrees, and 100
degrees from the selected origin. These are useful for
defining local, regional, teleseismic ranges.

MS_MAP_COAST A string specifying the coastline data set used for draw-
ing coastlines. Acceptable values are: Default coastline,
GSHHS crude, GSHHS low, GSHHS intermediate,
GSHHS high, GSHHS full.

MS_MAP_AXES_LIMIT Four comma separated floats specifying the min lat, max
lat, min lon, max lon for the map view. If these are set in
the config file, the map will automatically come up
zoomed to this view.

MS_MAP_AXES_LIMIT_MAX
As above, but these limits specify the entire allowable
range of the map (i.e. if you try to unzoom beyond this
range you won’t be able to). Default values are: -89.5,
89.5, -179.5, 179.5.

MS_MAP_PROJECTION A string specifying the map projection. Allowable values
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are: Stereographic, Orthographic, Azimuthal Equal-area,
Azimuthal Equidistant, Gnomonic, Satellite, Albers
Equal-area Conic, Lambert Conformal Conic, Mercator,
Miller Cylindrical, Equidistant Cylindrical, Oblique Merca-
tor, Transverse Mercator, Sinusoidal, Gall-Peters, Ham-
mer-Aitoff, Mollweide

MS_MAP_STA_MARKER A string specifying the marker used for the stations plot-
ted on the map. Acceptable values are: none, point, plus,
cross, asterisk, circle, square, diamond, triangle-up, trian-
gle-down, triangle-left, triangle-right, pentagram,
hexagram.

MS_MAP_STA_COLOR A 3 element comma separated list of rgb values (ranges
from 0=black to 1=full color) specifying the station symbol
color.

MS_MAP_STA_SIZE A single decimal value specifying the point size of the
station symbols.

MS_MAP_STA_FONTSIZE A single decimal value specifying the point size of the
font used to label the stations.

MS_MAP_STA_SEL_COLOR, STA_SEL_SIZE, STA_SEL_FONTSIZE
As above, but for the selected stations (to differentiate
them).

MS_MAP_ORG_MARKER, ORG_COLOR, ORG_SIZE, ORG_FONTSIZE
As above, but for origins rather than stations.

MS_MAP_ORG_SEL_COLOR, ORG_SEL_SIZE, ORG_SEL_FONTSIZE
As above, but for the selected origin (to differentiate it).

MS_MAP_DATA_DIR A string specifying the location of the data file read in
(e.g. topography).

MS_MAP_DATA_FILE A string specifying the name of the data file to be read in
(.e.g world15min.mf).

MS_MAP_GSHHS_DIR A string specifying the location of the coast line data files.

MS_MAP_TITLE A string specifying the title of the map.

MS_MAP_ZOOMBUTTONS A string (on, off) specifying whether or not the zoom but-
tons on the map are visible. To make screen dumps the
user may want to turn the buttons off.

MS_MAP_DATABUTTONS As above, but to control the visibility of the data set but-
tons.

MS_MAP_BORDER A string (on, off, fancy) to control whether or not a border
is shown on the map.
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MatSeis Appendix E:
MatSeis Accelerator Keys

Matseis offers several accelerator keys, or hot keys to assist the user in performing several of the

more routine tasks available within Matseis. The accelerator keys are accessed by holding down

the control-key (<ctrl>) and typing a single key (e.g. a) at the same time (<ctrl>-a). Here we list

the hot keys and their function.

<ctrl> - a Draw rubber band box to select arrivals

<ctrl> - e Delete selected waveforms

<ctrl> - f Launch Free Plot

<ctrl> - g Delete selected arrivals

<ctrl> - m Launch Measure Tool

<ctrl> - n Unselect waveforms

<ctrl> - o Load data for current origin

<ctrl> - p Load data for next origin

<ctrl> - q Remove processing window

<ctrl> - s Set processing window

<ctrl> - w Draw rubber band box to select waveforms

<ctrl> - x Zoom out by preset amount

<ctrl> - z Draw rubber band box and Zoom into defining area
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